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1 Introduction

1.1 Components of the documentation

The documentation of your device consists of the following parts:
Installation Guide
The Quickstart user guide answers the following questions:

Which software has to be installed to carry out a configuration?
How is the device connected up?

How can the device be contacted with LANconfig or WEBconfig?
How is the device assigned to the LANCOM Management Cloud?
How do | start the Setup Wizard (e.g. to set up Internet access)?
How do | reset the device?

Where can | find information and support?

vV VvV V V V VvV Vv

Quick Reference Guide

The Quick Reference Guide contains all the information you need to put your device into operation. It also contains all
of the important technical specifications.

Reference manual

This Reference Manual goes into detail on topics that apply to a variety of models. The descriptions in the Reference
Manual are based predominantly to the configuration with LANconfig.

Menu Reference Guide

The Menu Reference describes all of the parameters in LCOS LX. This guide is an aid to users during the configuration
of devices by means of the CLI. Each parameter is described briefly and the possible values for input are listed, as are
the default values.

@ All documents for your product which are not shipped in printed form are available as a PDF file from
www.lancom-systems.com/downloads/.

1.2 LCOS LX, an operating system from LANCOM

LCOS LX is the operating system for certain LANCOM access points and parts of the LANCOM family of operating systems.
The LANCOM operating systems are the trusted basis for the entire LANCOM product portfolio. Each operating system
embodies the LANCOM values of security, reliability and future viability.

> Maximum security for your networks

as each LANCOM operating system is carefully maintained and developed in-house and with the accustomed quality.
They are all guaranteed backdoor-free.

> Reliability of the highest order
as they receive regular release updates, security updates, and major releases over their entire product lifetime.

> Future viability for your networks


https://www.lancom-systems.com/downloads/
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according to the LANCOM Lifecycle Policy, i.e. they are free of charge for all LANCOM products and come with major
new features.

1.3 Validity

The functions and settings described in this manual are not all supported by all models or all firmware versions.
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2.1 Configuration software

There is no end of different situations in which configurations have to be carried out, or ways in which operators prefer
to work. This is why the device offers a wide range of ways to set up the configuration:

>

LANconfig — the menu-driven, clearly structured and easy way to set almost all parameters for a device. LANconfig
requires a configuration PC with a current Windows operating system. Refer to the chapters LANconfig — configuring
devices on page 7 and Configuring features with LANconfig on page 17 for further information.

WEBconfig — further information can be found in the chapters WEBconfig — monitoring and configuring devices on
page 8 and Configuring features with WEBconfig on page 65.

CLI - as an alternative to LANconfig, you can also use SSH to open a terminal session on the device and access the
command-line interface. TCP port 22 provides access to the device via SSH programs such as PuTTY.

LANCOM Management Cloud — the hyper-integrated solution for automated control of your network.

@ The default credentials for all configuration paths are:

> User: root
> Password: <Empty> (no password is set)

In the interests of security, you will be prompted to change the password when you use WEBconfig to access
the configuration for the first time.

@ Please note that all methods access the same configuration data.

2.1.1 LANconfig — configuring devices

From the easy commissioning of a single workplace device with convenient Installation Wizards to the overall management
of large scale installations—the spectrum of applications for LANconfig is wide:

Basic functions

vV VvV V VvV VvV Vv

Automatic detection of new, unconfigured devices

(Remote) configuration of devices via IP address, URL, or via the serial interface
Integration of Telnet, SSH, HTTPS and TFTP configuration

Context-based help on the configuration parameters

The Wizards provide customized input masks at every stage of installation
Backup connection setup

Management of large installations

>
>
>

Grouping
Central firmware distribution
Simultaneous configuration of multiple devices
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> Configuration script distribution

> WLAN group configuration

> Logging of all actions

> Creation of new “offline” configurations for all devices, for LCOS, and for versions of LCOS LX

2.1.2 WEBconfig — monitoring and configuring devices

Using WEBconfig, you can configure individual devices or monitor them during operation. WEBconfig is reached via
HTTP and HTTPS. If you use HTTP, the device automatically redirects you to an encrypted HTTPS connection.

@ WEBCconfig uses a self-signed SSL certificate, so this must be added as an exception in the browser for each
device.

The following provides an overview of the main components of WEBconfig, which are located in the left-hand section
in the sidebar.

LANCOM
I Q

Dashboard Dashboard

#t Neighborhood

I~ Monitoring System ssiDs Wi-Fi

4  WiFi configuration

System configuration Device LX-6400 ssiD 2.4GHz 5 GHz Authentication” 24GHz Channel6  802.11axtnig

o Name Documentation # Documentation + v WPA(2)}PSK / - \

= Location - < 2 { O\ 24%
Comment , \_/
P address 192.168.1.131/24, fe.. Clioms Channel load
Uptime 01:16:36

Firmuere ve.
5GHz Channel64 802.11ax+n#ac DFSYes

Nw —
Memary 4
- I‘ O\ @
\_/ . !
Clients Quality

Channel load

Connected clients L c T =

Name ¥ sSID Signal strength IP address MAC address Standards Mode Throughput

No data

I3 © 2018 - 2020 LANCOM Systems GmbH

Dashboard
The Dashboard displays status information of the device during operation.

> System — basic information about the device, e.g. the device name and the firmware version.

> WLAN — information about the load on the WLAN channels operated by the device.

> Connected stations — shows all WLAN stations currently connected to the device.

> Neighborhood — overview of the WLAN environment, especially the WLAN access points and WLAN routers that are
locally active.

> Monitoring — graphical representation of the WLAN throughput, LAN throughput, number of WLAN stations and
channel load over time.
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Configuration

> System configuration — configuration of basic parameters of your device, such as the device name or the IP settings
for managing the device.

> WLAN — the WLAN configuration is designed to assist the user with the most common settings and to eliminate the
hassle of configuring minor details. It remains possible to configure different scenarios.

Logs

This area outputs the device SYSLOG.

2.1.3 Command-line interface — command summary

The command-line interface is operated with the following commands. An overview of the available configuration
parameters and actions is available in the LCOS LX Menu Reference Guide.

@ Which commands are available depends upon the equipment of the device.

@ Changes to the configuration are not immediately boot-persistent. They have to be saved explicitly by using the
command f£lash.

Table 1: Overview of all commands available at the command line

Command Description

add [<Path>] Adds a row to the table.
cd <Path> Changes the current menu or directory.
default Resets the table or the value to the default setting.

@ This command works recursively. Therefore, all values and tables in the
current path and those below it will be reset.

del <Path> Deletes the value or the table row in the branch of the menu tree referenced by
<Path>.

do <Path> [<Parameter>] Executes the action in the current or referenced directory. If the action has additional
parameters, they can be added at the end.

exit Ends the terminal session.

flash Store the configuration

Changes to the configuration are not immediately boot-persistent. They
have to be saved explicitly by using the command £1ash.

1s [<Path>] Displays the contents of the current directory or path.
passwd <Password> Changes the password of the current user account.

set <Index> {Column} <Value> Sets the value of a table row in a specific column to <Value>.

set <Path> <Value (s)> Sets the value or values of a specific path to the specified value(s).

show diag [<Parameter>] Output diagnostic information on the CLI.

show 3rd-party-licenses Output the device license information on the CLI.

startlmc <Activation Code> After you have generated an activation code in the LANCOM Management Cloud,

you use this code to pair the device with the LANCOM Management Cloud. You can

[Domain] . . .
optionally specify a new LMC domain as well.
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Command Description

sysinfo Shows the system information (e.g., hardware release, software version, MAC
address, serial number, etc.).

trace [--log]l [+]-1#]2] Starts (+) or stops () a trace command to output diagnosis data. # switches between

<Parameter> different trace outputs and 2 displays a help text. The parameter --1og restricts

the output to “historical” log information. For further information on this command
refer to the section Diagnosis on page 93.

Legend

>

Characters and brackets:

> Objects, in this case dynamic or situation-dependent, are in angle brackets.
> Round brackets group command components, for a better overview.

> Vertical lines (pipes) separate alternative inputs.

> Square brackets describe optional switches.

It follows that all command components that are not in square brackets are necessary information.

<Path>:

> Describes the path name for a menu or parameter, separated by “/".
> .. means: one level higher

> . means: the current level

<Value>:

> Describes a possible input value.
> wnis a blank input value

<Name>:

> Describes a character sequence of [0...9] [A...Z] [a...2] [ _].
> The first character cannot be a digit.
> There is no difference between small letters and capital letters.

<Filter>:

> The output of some commands can be restricted by entering a filter expression. Filtering does not occur line by
line, but in blocks, depending on the command.

> Afilter expression starts with the "@" symbol by itself and ends either at the end of the line or at a *;" (semicolon)
to end the current command.

> Afilter expression also consists of one or more search patterns, which are separated by blank spaces and preceded

either by no operator (OR pattern), a "+" operator (AND pattern) or a "-" operator (NOT pattern).

> For the execution of the command, an information block is output exactly when at least one of the "OR" patterns,
all "AND" patterns or none of the "NOT" patterns matches. Capitalization is ignored.

> For a search pattern to contain characters for structuring in the filter syntax (e.g., blank characters), then the
entire search pattern can be enclosed in "". Alternatively, the symbol "\" can be placed before the special characters.
If you want to search for a quotation mark (") or "\", another "\" symbol has to be placed in front of it.

@ Entering the start of the word, if it is unique, is sufficient.
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Explanations for addressing, syntax and command input

> All commands and directory/parameter names can be entered using their short-forms as long as they are unambiguous.
For example, the command cd setup can be shortened to cd se. The input cd /s is not valid, however, since
it corresponds to both cd /Setupand cd /Status.

> The values in a table row can alternatively be addressed via the column name or the position number in curly brackets.
The command set 2 in the table shows the name, the possible input values and the position number for each

column.

> Multiple values in a table row can be changed with one command, for example in the WLAN networks
(/Setup/WLAN/Network):

> add Guest Guest 1234567890 createsanew network named Guest, SSID Guest, and key 1234567890.

@ The order of the values must correspond to their order in the table. Values that should not be changed
can be specified with a *.

> set Guest * 0987654321 changes the value Key in the network Guest. Using the * leaves the SSID
unchanged.
> set Guest {Key} 1234567890 sets the value Key in the network Guest. Individual columns can be

referenced by the column name in parentheses.

> Names that contain spaces must be enclosed within quotation marks (*").

Command-specific help

> A command-specific help function is available for actions and commands (call the function with a question mark as
the argument). For example, show 2 displays the options available with the show command.

1
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3 Feature descriptions

A selection of WLAN features is described in the following.

3.1 WLC layer-3 tunnel

Layer-3 tunneling involves the extended application of the CAPWAP protocol (control and provisioning of wireless access
points) as used by WLAN controllers (WLC) to manage WLAN access points. It allows WLAN data to be fed into the LAN
via a central WLAN controller by establishing a direct data tunnel between the WLAN controller and the access point.
For configuration, one of the available WLC tunnel interfaces has to be set in the logical network profile of the WLC
under WLAN Controller > Profiles > Logical WLAN networks (SSIDs) > Connect SSID to. The data traffic from that
SSID is now directed to the selected WLC tunnel interface of the WLC. The WLC tunnel interface can now be used for an
ARF network or in the LAN bridge of the WLC.

Layer-3 tunneling is ideal for environments operating unmanaged switches or where no further VLAN configuration of
the switches is possible. This allows data tunnels to be set up very quickly and easily without needing a VLAN infrastructure
between the WLAN controller and access point to isolate the data traffic of individual SSIDs from one another. A VLAN
infrastructure is only required at the transfer point between the WLAN controller and the local networks because data
from the individual SSIDs is transported in a layer-3 tunnel between the access point and WLAN controller. Alternatively,
the WLAN controller can use its router function to route data delivered via the tunnel to other IP networks or to the
Internet.

@ To use this feature, the LANCOM WLAN controller requires LCOS 10.42 RU3 or higher.

3.2 Band steering

12

The IEEE 802.11 standard contains virtually no criteria by which a WLAN client should select the access point for a
connection. While there are, for example, general guidelines for the preference given to an access point with a higher
RSS! value (i.e. the received signal strength), WLAN clients do not, in practice, adhere strictly to these definitions or the
general guidelines. If both 2.4 GHz and 5 GHz are used to broadcast an SSID, there is normally no way of influencing
the client as regards the preferred frequency band.

“Client steering” is based on the principle that many clients discover the available access points by means of an active
scan. Active scanning here means that a client sends probe requests containing the network ID to which the client is to
connect. Access points with this ID then send a test response, enabling the client to create a list of available access
points. The vast majority of WLAN clients only connect to access points from which they have received a probe response,
and this can be used to steer their selection process.

There are several, sometimes highly advanced, criteria for steering. One of these criteria relates to the wireless frequency
ranges used for client communication. Modern dual-band WLAN clients are expected to prefer the 5-GHz frequency band
over the now overcrowded 2.4-GHz band. Band Steering is the term given to purposefully assigning a WLAN client to a
particular frequency band or range.

The list of detected or “seen” clients contains all clients from which the access point has received a test request packet.
In combination with the radio frequency on which the WLAN client sends the probe request, this list is one of the bases
used by the access point to decide whether or not to respond to the request.
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Other criteria depend on the reported client IDs and the configuration of the devices. It may be the case, for example,
that fewer SSIDs are reported on the preferred frequency band than are on the one with the lower preference. Similarly,
too low a transmit strength when SSIDs are reported can result in the client not receiving any probe responses at all on
the preferred frequency band. For the latter scenario, it is important to ensure that the access point does not suppress
probe responses on the less favored frequency band.

To configure the access point's band steering function with LANconfig, go to Wireless LAN > Client management.

3.3 Fast roaming

By operating authentication according to the IEEE 802.1X standard and key management according to the IEEE 802.11i
standard, modern WLAN installations offer a high degree of security and confidentiality for the transmitted data. However,
these standards require transmission of additional data packets during the connection negotiation as well as additional
computing power on the client and server.

IEEE 802.11 originally required up to six data packets to establish a data connection between a WLAN client and an
access point. The standard extension IEEE 802.11i improved on weak points of WEP encryption; however, depending
on the authentication method, it substantially increased the length of the login process.

This extra time for the WLAN client to login to the access point is not a problem for non-time-critical applications.
However, for smooth, loss-free roaming of a WLAN client from one access point to the next, a delay of more than 50 ms
is not acceptable. Examples include Voice-over-IP (VoIP) or the application in real-time industrial environments. In this
context, roaming means that the network connection passes from one access point to the other without interruption.

Methods such as pair-wise master key caching (PMK caching), pre-authentication, opportunistic key caching (OKC) and
the use of central WLAN controllers (WLC) for key management improve the time for the key negotiation between the
WLAN client and access point during login. Despite this, the comparatively long time required for key negotiation between
the WLAN client and the access point has still not been reduced to a viable extent.

Along with the improved encryption protocols, IEEE 802.11e makes it possible to reserve additional bandwidth with the
access point. This allows the WLAN client to prevent interruptions, for example for VoIP connections at times of high
network loads at the access point. For roaming from one access point to the next, the WLAN client must again reserve
this additional bandwidth on the new access point. However, the additional management frames required for this
considerably increase the login time.

The IEEE 802.11r standard provides a simplified authentication process for mobile WLAN clients to roam trouble-free
from one access point to the next. The goal is to once again reduce the number of data packets for the login on the
access point to the four to six packets known from IEEE 802.11.

Similar to opportunistic key caching (OKC), a centralized key management (preferably by a WLC) supplies the access
points connected to it with the credentials of the WLAN clients. In contrast to OKC, the WLAN client performing fast
roaming can detect whether the access point supports IEEE 802.11r

Access points managed by the WLC transmit the “mobility domain information element (MDIE)" to inform WLAN clients
within range about, among other things, which “mobility group” the access point belongs to. Based on this information,
the WLAN client detects whether it belongs to the same domain and can therefore authenticate without delay. This
mobility domain is announced to a WLAN client the first time it authenticates at an access point.

The domain identifier and other special keys generated during the initial authentication and transmitted to all managed
access points now reduce the stages of negotiation to the desired four to six steps when authenticating at a new access
point.

To avoid futile and thus time-wasting login attempts with expired PMKs, IEEE 802.11r provides additional information
about the validity periods of keys. In this manner, the client negotiates a new PMK while connected to the current access
point. This is also valid on the access point that the WLAN client wants to connect to next.

Additionally, IEEE 802.11r uses “resource requests” to reserve additional bandwidth on the new access point, so that
there is no need to cause added delay by transferring unnecessary data packets during the IEEE 802.11e authentication.

13
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@ Older WLAN clients may have trouble establishing a connection to an SSID with enabled 802.11r. Therefore, it
is advisable to use two SSIDs here: One SSID for older clients without 802.11r support and another SSID with
enabled 802.11r for clients that support 802.11r.

Fast roaming is setup in LANconfig under Wireless LAN > General > Encryption > WPA2/3 key management.

@ Fast roaming is possible between devices based on LCOS and LCOS LX.

Fast roaming by Inter Access Point Protocol (IAPP)

In order to use fast roaming with IAPP, you need to assign an individual IAPP passphrase in the WLAN encryption settings
for each interface. This is used to encrypt the pairwise master keys (PMKs). Access points that share a matching IAPP
passphrase (PMK-IAPP secret) are able to exchange PMKs between one another and ensure uninterrupted connections.
When a client switches to another access point, the new access point sends a handover request to the former access
point. The former access point then deletes the client from its station table. The handover request contains the client's
MAC address, so that devices in the LAN are informed about the new routing and can update their mapping table.

To enter the IAPP passphrase in LANconfig, navigate to Wireless LAN > General > Encryption > PMK-IAPP secret.

@ Please note that to use Fast Roaming by IAPP, it is necessary to select Fast Roaming in the encryption settings
under WPA2 key management.

3.4 LANCOM Enhanced Passphrase Security (LEPS)

14

LANCOM Enhanced Passphrase Security (LEPS) allows a set of passphrases to be configured and assigned to individual
users, groups or MAC addresses. This avoids having one global passphrase for an SSID. Instead, there are several
passphrases, which can then be distributed individually.

This is useful for onboarding devices into the network. For example, a network operator “onboarding” multiple WLAN
devices into different areas of the network does not want to configure each specific device; instead this should done by
the users of the devices themselves. In this case, users are given a preshared key for the company WLAN for use with
their own devices. LEPS is configured entirely on the infrastructure side, which assures full compatibility to third-party
products.

The security issue presented by global passphrases is fundamentally remedied by LEPS. Each user is assigned their own
individual passphrase. If a passphrase assigned to a user should “get lost” or an employee with knowledge of their
passphrase leaves the company, then only the passphrase of that user needs to be changed or deleted. All other
passphrases remain valid and confidential.

Along with passphrases for users, individual passphrases consisting of any sequence of 8 to 63 ASCII characters can
also be assigned to MAC addresses. Authentication at the access point is only possible with the correct combination of
passphrase and MAC address.

This combination makes the spoofing of the MAC addresses futile—and LEPS thus shuts out a potential attack on the
ACL. If WPA2 is used for encryption, the MAC address can indeed be intercepted—nbut this method never transmits the
passphrase over wireless. This greatly increases the difficulty of attacking the WLAN, because knowledge of both the
MAC address and the passphrase is required before encryption can be negotiated.

Compared to LEPS for users, the administrative overhead is slightly higher because the MAC address has to be entered
for each device.

@ For technical reasons, LEPS is only compatible with WPA version WPA2.

@ For technical reasons, LEPS is not compatible with Fast Roaming for user accounts that have a passphrase but
no MAC address.
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3.5 WPA3 (Wi-Fi Protected Access 3)

Compared to the predecessor standard WPA2 introduced by the Wi-Fi Alliance in 2004, the WPA3 standard introduced
in 2018 offers improved security by combining various security methods. Like WPA2, WPA3 also exists in the versions
WPA3-Personal and WPA3-Enterprise.

WPA3-Personal uses the Simultaneous Authentication of Equals (SAE) authentication method, which only requires a
password for authentication but which prevents brute-force and dictionary attacks. Furthermore, for the first time this
method offers forward secrecy, i.e. captured WPA3-secured traffic cannot be decrypted subsequently after the attacker
gains knowledge of the pre-shared key.
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In addition, the WPA3-Enterprise uses the Commercial National Security Algorithm (CNSA) Suite B cryptography. Suite
B ensures that all links in the encryption chain match with one another. Suite B forms classes of bit lengths for hashed,
symmetric, and asymmetric encryption in order to provide suitable levels of protection. For example, an SHA-2 hash with
256 bits matches AES with 128 bits. Where Suite B is operated, the support of all other combinations is expressly excluded.
Consequently, the encryption chain consists of links of equal strength.

Both variants now require the use of protected management frames (PMF) according to IEEE 802.11w. PMF prevents
attackers from computing the WLAN password from captured material gained by using fake management frames to
force a disassociation and then eavesdropping the re-authentication.

3.5.1 WPA3-Personal

In the WLAN encryption settings under Wireless LAN > WLAN networks > Encryption, the WPA versions WPA3 and
WPA2/3 are available for selection.

15
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With WPA3 selected, only WLAN clients that support WPA3-Personal will be able to login. This configuration enforces
authentication with the Simultaneous Authentication of Equals (SAE). Similarly, this SSID enforces the use of PMF
(Protected Management Frames as per IEEE 802.11w), a mandatory part of WPA3,

By selecting WPA2/3, these two versions of WPA are offered in parallel. This option allows clients that only support
WPA?2 to operate in parallel with clients that already support WPA3. For WPA3-compatible WLAN clients, this configuration
enforces the use of PMF; for WPA2-compatible WLAN clients, PMF is offered as an option for backwards compatibility.

3.5.2 WPA3-Enterprise

16

WPA3-Enterprise does not fundamentally change or replace the protocols defined in WPA2-Enterprise. Rather, it set out
policies to ensure greater consistency in the application of these protocols and to assure the desired level of security.

In the WLAN encryption settings under Wireless LAN > WLAN networks > Encryption, the WPA versions WPA3 and
WPAZ2/3 are available for selection.

By selecting WPA3, only WLAN clients that support WPA3-Enterprise will be able to log in. This SSID enforces the use
of PMF (Protected Management Frames as per IEEE 802.11w), a mandatory part of WPA3.

By selecting WPA2/3, these two versions of WPA are offered in parallel. This option allows clients that only support
WPA?2 to operate in parallel with clients that already support WPA3. For WPA3-compatible WLAN clients, this configuration
enforces the use of PMF; for WPA2-compatible WLAN clients, PMF is offered as an option for backwards compatibility.

Suite B cryptography

In addition, the WPA3-Enterprise uses the Commercial National Security Algorithm (CNSA) Suite-B cryptography. Suite
B ensures that all links in the encryption chain match with one another. Suite B forms classes of bit lengths for hashed,
symmetric, and asymmetric encryption in order to provide suitable levels of protection. For example, an SHA-2 hash with
256 bits matches AES with 128 bits. Where Suite B is operated, the support of all other combinations is expressly excluded.
Consequently, the encryption chain consists of links of equal strength.

@ Further information on CNSA Suite B can be found at the following link: CNSA algorithm suite factsheet

Use of the following EAP cipher suites are enforced:

> TLS_ECDHE_ECDSA_WITH_AES_256_GCM_SHA384
> TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384
> TLS_DHE_RSA_WITH_AES_256_GCM_SHA384

@ Other cipher suites can no longer be used. Also enforced are a minimum key length of 3072 bits for the RSA and
Diffie-Hellman key exchange, as well as 384 bits for the ECDSA and ECDHE key exchange. The session key type
AES-GCMP-256 is also enforced.

If these cipher suites are not supported by the WLAN clients or the remaining infrastructure (e.g. the RADIUS
server), then no connection is possible!

@ The RADIUS server integrated in the LCOS supports the cipher suites mentioned here.


https://apps.nsa.gov/iaarchive/library/ia-guidance/ia-solutions-for-classified/algorithm-guidance/commercial-national-security-algorithm-suite-factsheet.cfm
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4 Configuring features with LANconfig

The following explains all of the options for adjusting settings with LANconfig. These depend on the device, so not all

of the listed options are available with every device.

4.1 Management

The Management section contains general settings for the device.

4.1.1 General

The device settings described here are to be found under Management > General.

Device name: |D0cumentation |

- Location: | |

Administrator: | |

Comments

Name

Configure the device name here.
Location

Configure the device location here.

Administrator
Here you configure the name of the device administrator.

Comments

Use the comment fields to enter any comments about the device configuration.

17
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4.1.2 Admin

18

The settings for changing the main device password and SNMP can be found under Management > Admin.

Device configuration

root

Main device password: a Show

Set

./f\ The password can not be displayed in the clear because the device configuration
= contains the password only in hashed form. You can use this dialogue to change the
password.

SNMP
Configure the access rights for all protocol versions of SNMP here.

SNMP settings...

Main device password

The settings for changing the main device password are located under Management > Admin > Device configuration.

Device configuration

root

Main device password: a Show

./f\ The password can not be displayed in the clear because the device configuration
= contains the password only in hashed form. You can use this dialogue to change the
password.

Administrator name

Here you configure the login name of the device administrator. Depending on the device, this name may be
fixed and will only be displayed here.

Main device password

Configure the main device password here. Depending on the device, this may be stored as a hash value and
consequently cannot be displayed as plain text.

If you enter a new password, a field appears to repeat the entry of the changed password. Your input is not
displayed, so this serves to verify your input. Alternatively, you can activate the option Show. Your input is
then displayed in a legible form. We do not recommend this option if other individuals can view your screen
while you type.

Simple Network Management Protocol (SNMP)

The Simple Network Management Protocol (SNMP) enables devices on a network to be monitored and configured from
a central instance. Since the initial release of SNMPv1 in 1988, it has continued to evolve with the versions SNMPv2 and
SNMPv3 to meet the needs of increasingly complex network infrastructures and the demands for user-friendliness,
security and flexibility.

The protocol SNMP (simple network management protocol) meets the highest standards for convenient management
and monitoring of a network. It allows for the early detection of problems and errors on a network and offers support
in eliminating them. The simple network management protocol allows a central instance to monitor and configure the
devices on a network from, and it regulates the communication between the monitored devices and the monitoring
station. This means that parameters such as the status of the device, CPU utilization, the temperature of a device, its
connection status, errors, and others can be monitored and analyzed, for example with LANmonitor. The administrator
benefits from active support with network management and is helped to detect problems at an early stage. The latest
SNMPv3 version of the protocol, in contrast to the previous versions SNMPv1 and SNMPv2, now enables encrypted data
communication between the network and its management system, which provides a crucial security factor. By offering
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different user accounts for authentication, the integrated user administration provides optimal control over access to
the configurations. You have precise control over the rights to the different levels of access that administrators receive,

and the network is optimally protected.

SNMP components

The typical SNMP architecture consists of three components:

SNMP manager

The SNMP manager sends SNMP requests to the SNMP agent and evaluates the SNMP responses from it.
LANconfig and LANmonitor act as this type of SNMP manager. LCOS LX devices comply with the standards
SNMPv1, SNMPv2, and SNMPv3, so it is possible to use an alternative SNMP administration and management

software.
SNMP agent

The SNMP agent is a module that is active on the managed device. When it receives a request from the SNMP
manager, it retrieves the requested status data from the MIB in the device and returns this information to the
SNMP manager as an “SNMP response”. Depending on the configuration, an SNMP agent that detects certain
changes of state in the managed device can independently act to send an “SNMP trap” to the SNMP manager.
It is also possible to send a notification to the device administrator by means of a SYSLOG message or e-mail.

Managed device

The status of this device is stored in its Management Information Base (MIB). When requested by the SNMP

agent, the device reads out this information and returns it to the SNMP agent.

By default, SNMP requests and SNMP responses are exchanged between the SNMP manager and SNMP agent by the

User Datagram Protocol (UDP) on port 161. SNMP traps are transmitted with the UDP via port 162 by default.

SNMP versions

The differences between the various versions of SNMP can be summarized as follows:

SNMPv1

Version 1 was launched in 1988 and has long been regarded as the de facto standard for network management.
In SNMPv1, the SNMP manager authenticates at the SNMP agent by means of a community string, which
must be identical on both components. The security of this is very limited, as the community strings are
transmitted in cleartext. The increase in demands for secure network communication necessitated a revision

of version 1.
SNMPv2

After 1993, the main improvements in version 2 were to its user-friendliness. Numerous intermediate steps
and the repeated rejection of concepts eventually led to the version SNMPv2c. This version allows large
amounts of data to be requested via a GetBul kRequest command and also the communication between

SNMP managers. However, the exchange of the community strings was still as cleartext as with version 1.

SNMPv3

From 1999, version 3 finally met the by then much-needed security requirements. Among other things, the
communication was encrypted and the communication partners first had to authenticate and authorize
themselves. Also, the structure of SNMP became more modular so that improvements, for example in encryption

technologies, can be incorporated into SNMPv3, without having to completely redesign the standard.

LCOS LX supports the following SNMP versions:

> SNMPv1
> SNMPv2c
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> SNMPv3

SNMPv3 basics

The SNMP protocol structure has changed significantly with version 3. SNMPv3 is now divided into a number of modules
with clearly defined interfaces that communicate with one another. The three main elements in SNMPv3 are “Message
Processing and Dispatch (MPD)", “User-based Security Model (USM)” and “View-based Access Control Mechanism
(VACM)".
MPD

The MPD module is responsible for the processing and dispatch of inbound and outbound SNMP messages.
Usm

The USM module manages security features that ensure the authentication of the users and the encryption
and integrity of the data. SNMPv3 introduced the principle of the “security model”, so that the SNMP
configuration in LCOS LX primarily uses the security model “SNMPv3". However, for compatibility reasons it
may be necessary to also take the versions SNMPv2c or even SNMPv1 into account, and to select these as
the “security model” accordingly.

VACM

VACM ensures that the sender of an SNMP request is entitled to receive the requested information. The
associated access permissions are found in the following settings and parameters:

SNMPv3-Views

"SNMPv3-Views" collect together the content, status messages, and actions of the Management Information
Base (MIB) that are permitted to receive or execute an SNMP request. These views can be single values, but
also complete paths of the MIB. This content is specified by the OIDs of the MIB entries.

In this way, a successfully authenticated sender of an SNMP request only has access to that data specified in
the applicable SNMPv3 views.

SNMPv3-Groups
“SNMPv3-Groups” collect users with the same permissions into a specific group.
Security-Levels

"Security levels” relate to the exchange of SNMP messages. The following levels can be selected:

NoAuth-NoPriv

The SNMP request is valid without the use of specific authentication methods. Authentication merely requires
the user to belong to an SNMP community (for SNMPv1 and SNMPv2¢) or to specify a valid user name (for
SNMPv3). Data transfer is not encrypted.

Auth-NoPriv

SNMP requests are only processed following authentication by means of the HMAC-MD5 or HMAC-SHA
algorithm, but data transfer is not encrypted.

Auth-Priv

SNMP requests are only processed following authentication by means of the HMAC-MD5 or HMAC-SHA
algorithm, and data transfer is encrypted by the DES or AES algorithm.

Context

“Context” is used to distinguish the various SNMP entities.
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Configuring SNMP
The SNMP settings of the device can be found under Management > Admin > SNMP > SNMP settings.

SNMP settings ? X
Operating: Yes ~
Po
Protocal versions
] SNMPw1 []SMMPv2
SNMPv3

SMNMPv3 access settings for administrators

Decide whether administrators can access the device through
SNMPv3 or not.

Administrators have SNMPv3 access according to their
device access rights

Access configuration
Communities...
Users...
Groups...
Accesses...

Views...

Traps

Send information about system events {raps) to the target
addresses specified in the following table

Target addresses...

Target parameter. ..

Cancel

Operation

Enable SNMP for the SNMP protocol versions specified below, which the device should support for SNMP
requests and SNMP traps.

Port

If necessary, adjust the port used for SNMP. Default: 161
Protocol versions

SNMPv1

Enables SNMPv1.

SNMPv2
Enables SNMPv2c.

SNMPv3
Enables SNMPv3.

SNMPv3 access settings for administrators
Administrators have SNMPv3 access according to their access rights

Enable this option if registered administrators, including the root user, should also have access via SNMPv3.
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Access configuration

SNMP communities

Administrators of networks with SNMP management systems can precisely control the access rights to various access
levels. SNMP of the versions v1 and v2 do this by encoding the access credentials as part of a “community”. Authentication
is optionally handled

> by the public community (unlimited SNMP read access),

> by a master password (limited SNMP read access),
> or a combination of user name and password, separated by a colon (limited SNMP read access)

A community collects certain SNMP hosts into groups, in part so that it is easier to manage them. On the other hand,
SNMP communities offer a certain degree of security because an SNMP agent only accepts SNMP requests from participants
in a community that it knows.

By default, your device answers all SNMP requests that it receives from LANmonitor or another SNMP management
system with the community pub1ic. Because this represents a potential security risk, especially with external access,

LANconfig gives you the option of defining your own communities.

@ This configuration is relevant for the SNMP versions v1 and v2c only.

Communities - Mew Entry ? *
Cancel
Entry active

Activates or deactivates this SNMP community.
Name

Enter a descriptive name for this SNMP community.
Security-Name

Here you enter the name for the access policy that specifies the access rights for all community members.

@ The SNMP community public is set up by default, and this provides unrestricted SNMP read access.

For SNMPv1 or SNMPv2¢, you force the entry of login data for SNMP read-only access by disabling the public

community in the list of the SNMP communities. This setting only allows information about the state of the device, current
connections, reports, etc., to be read out via SNMP after the user authenticates at the device. Authorization can be
conducted either with the administrator-account access credentials or an access account created for the individual SNMP
community.

Disabling the community pub1ic has no effect on accessing for other communities created here. An individual SNMP

read-only community always provides an alternative access path that is not tied to an administrator account.
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Users

Individual users can be granted access to the device in addition to the administrators registered on it. Here you configure
the authentication and encryption settings for these users when operating SNMPv3.

Users - Mew Entry ? X
Authentication-Protocal: None ~
Authentication-Password: I:I Show
Empty
Privacy-Protocol: Mone ~
Privacy-Password: I:I Show
Empty
Cancel

Entry active

Activates or deactivates this user.
User name

Enter a descriptive name for this user.

Authentication

Specify the method that the user is required to use to authenticate at the SNMP agent. The following options
are available:

None

Authentication of the user is not necessary.
HMAC-MD5

Authentication is performed using the hash algorithm HMAC-MD5-96 (hash length 128 bits).
HMAC-SHA

Authentication is performed using the hash algorithm HMAC-SHA (hash length 160 bits).
HMAC-SHA224

Authentication is performed using the hash algorithm HMAC-SHA- 224 (hash length 224 bits).
HMAC-SHA256

Authentication is performed using the hash algorithm HMAC-SHA- 256 (hash length 256 bits).
HMAC-SHA384

Authentication is performed using the hash algorithm HMAC-SHA- 384 (hash length 384 bits).
HMAC-SHA512

Authentication is performed using the hash algorithm HMAC-SHA- 512 (hash length 512 bits).

Authentication password

Enter the user password necessary for authentication here and repeat it in the box below.

Encryption

Specify which encryption method is used for encrypted communication with the user. The following options
are available:
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None
Communication is not encrypted.
DES

Encryption is performed with DES (key length 56 bits).
AES128

Encryption is performed with AES128 (key length 128 bits)
AES192

Encryption is performed with AES192 (key length 192 bits)
AES256

Encryption is performed with AES256 (key length 256 bits)

Privacy password

Enter the user password required by the encryption here and repeat it in the box below.

Groups

By configuring SNMP groups, it is easy to manage and assign the authentication and access rights of multiple users. By
default, the configuration is set up for SNMP access via LANmonitor.

Groups - Mew Entry ? X

Security-Model: Any

Cancel

Entry active
Activates or deactivates this group.

Security model
SNMPv3 introduced the principle of the “security model”, so that the SNMP configuration in LCOS LX primarily
uses the security model “SNMPv3". However, for compatibility reasons it may be necessary to also take the
versions SNMPv2c or even SNMPv1 into account, and to select these as the “security model” accordingly.
Select one of the following entries accordingly:
Any
Any model is accepted.
SNMPv1
Data is transmitted by SNMPv1. Users are authenticated by the community string in the SNMP message only.
Communication is not encrypted. This corresponds to the security level “No authentication/No privacy”.
SNMPv2_C

Data is transmitted by SNMPv2c. Users are authenticated by the community string in the SNMP message only.
Communication is not encrypted. This corresponds to the security level “No authentication/No privacy”.
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SNMPv3_USM
Data is transmitted by SNMPv3. Security levels for the user’s authentication and communication are possible,
and these levels are activated with the access rights.

Security-Name

Here you select a security name you assigned to an SNMP community.

Group name

Here you select a group that you want to define under Access rights.

Access rights

This table brings together the different configurations for access rights, security models, and views.

Accesses - New Entry ? X
Security model: Any w
Minimal security level: AuthPriv ~
Readonly Traps: Select
Cancel
Entry active

Activates or deactivates this entry.
Group name
Enter a descriptive name for this group.

Security model

Activate the appropriate security model here.

Minimal security level

Specify the minimum security level for access and data transfer.

NoAuthNoPriv (No authentication/No privacy)

The authentication is performed by the specification and evaluation of the user name only. Data communication
is not encrypted.

AuthNoPriv (Authentication/No privacy)

Authentication makes use of the hash algorithms set for the user. Data communication is not encrypted.
AuthPriv (Authentication and privacy)

Authentication makes use of the hash algorithms set for the user. Data communication is encrypted by DES
or AES algorithms.
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Read

Set the view of the MIB entries for which this group is to receive read rights. Available values are those defined

under Views. Previously defined views are “Full Access”. “LANmonitor Access”. “Setup Access” and “Status
Access”.

Write

Set the view of the MIB entries for which this group is to receive write rights. Available values are those
defined under Views. Previously defined views are “Full Access”. “LANmonitor Access”. “Setup Access” and

“Status Access”.
Read-only traps

Set the view of the MIB entries for which this group is to receive read rights for traps. Available values are

those defined under Views. Previously defined views are “Full Access”. “LANmonitor Access”. “Setup Access”
and “Status Access”.

Views

Here you collect the different values or even entire branches of the device MIB, which each user is entitled to view or
change in keeping with the corresponding access rights.

Views - New Entry ? X
Access to subtree: Included ~
Cancel
Entry active

Activates or deactivates this view.
Name

Enter a descriptive name for this view.
OID subtree

Use a comma-separated list of the relevant OIDs to decide which values and actions from the MIB are included
in or excluded from this view.

@ The OIDs can be found in the device MIB, which you can download from
www.lancom-systems.com/downloads/.

Access to subtree

Here you decide whether the specified OID subtrees are “added” or “removed” from the view.

Traps

If you enable the option Send information about system events (traps) to the target addresses specified in the
following table, the recipients configured under Target addresses and Target parameters will receive the
corresponding information.

26


https://www.lancom-systems.com/downloads/

LCOS LX 5.32

4 Configuring features with LANconfig

Target addresses

The list of target addresses is used to configure the addresses of the recipients to whom the SNMP agent sends the
SNMP traps.

Target addresses - New Entry ? X
Target parameter name: Select
Cancel

Entry active

Activates or deactivates this entry.
Name

Give the entry a descriptive name here.
Transport address

Configure the address of the recipient here. This address describes the IP address and port number of a
recipient of an SNMP trap and is specified in the syntax “<IP address> : <Port>" (e.g. 128.1.2.3:162). UDP
port 162 is used for SNMP traps.

Target parameter name

Here you select the desired entry from the list of recipient parameters.

Target parameter name

In this table you configure how the SNMP agent handles the SNMP traps that it sends to the recipient.

Target parameter - New Entry ? X
Message-Processing-Model; SNMPv1 ~
Security-Model: SNMPv1 ~
Security-Level: MoAuth Mo Priv ~

Cancel

Entry active

Activates or deactivates this entry.
Name

Give the entry a descriptive name here.
Message processing model

Here you specify the protocol for which the SNMP agent structures the message.
Security model

SNMPv3 introduced the principle of the “Security Model”, so that the SNMP configuration in LCOS LX primarily
uses the security model “SNMPv3". However, for compatibility reasons it may be necessary to allow for the
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versions SNMPv2c or even SNMPv1, and to select these accordingly. Select one of the following entries
accordingly:

Any

Any model is accepted.

SNMPv1

Data is transmitted by SNMPv1. Users are authenticated by the community string in the SNMP message only.
Communication is not encrypted. This corresponds to the security level “NoAuthNoPriv".

SNMPv2_C

Data is transmitted by SNMPv2c. Users are authenticated by the community string in the SNMP message only.
Communication is not encrypted. This corresponds to the security level “NoAuthNoPriv".

SNMPv3_USM

Data is transmitted by SNMPv3. This can only be selected together with SNMP users. The effective possible
security level depends on the user's chosen authentication and encryption methods.

Security-Name
Here you select a security name you assigned to an SNMP community.
Security level

Set the security level that applies for the recipient to receive the SNMP trap.

NoAuthNoPriv (No authentication/No privacy)

The authentication is performed by the specification and evaluation of the user name only. Data communication
is not encrypted.

AuthNoPriv (Authentication/No privacy)
Authentication makes use of the hash algorithms set for the user. Data communication is not encrypted.
AuthPriv (Authentication and privacy)

Authentication makes use of the hash algorithms set for the user. Data communication is encrypted by DES
or AES algorithms.

4.1.3 LMC

Settings that relate to the configuration and monitoring of your device via the LANCOM Management Cloud (LMC) are
located under Management > LMC.

LANCOM Management Cloud

If you want to use the LANCOM Management Cloud to configure and monitor the device, you
must specify the domain of the services.

Operating: No -

Here you can specify the domain of the services to which the device connects.

LMC-Domain: |c|0ud.lanc0m.de |

Rollout project 1D: |

|
Rollout location 1D: | |
|

Rollout device role: |

Operation

Specify whether the device should be managed via the LMC.
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No
The device does not connect to the LMC.

Yes
The LMC manages the device.

LMC domain

Enter the domain name for the LMC here. By default, the domain is set to the Public LMC for the first
connection. If you wish to manage your device with your own Management Cloud (“Private Cloud” or
“on-premises installation”), please enter your LMC domain.

Rollout project ID

Enter the project ID of this device in the LMC. The first time the device connects to the LMC, it will be assigned
accordingly.

Rollout location ID

Enter the location of this device in the LMC. The first time the device connects to the LMC, it will be assigned
accordingly.

Rollout device role

Enter the role assigned to this device in the LMC. The first time the device connects to the LMC, it will be
assigned accordingly.

4.1.4 Extended

Here you find the settings for the LED functions and the option to send the syslog to external servers.

LED

The settings for the LED functions are located here. These are located under Management > Extended.

LED

LED-Mode: On ~
LED-Cff-Seconds: 300
LED-Mode

Choose between the different LED modes.

On
The LED(s) of the device are permanently in operation and signal the operating state.

off
The LED(s) of the device are switched off immediately after starting.

Timed off

The LED(s) of the device are switched off after the configured time.

@ Refer to the Quick Reference Guide for device-specific details about LED signaling.
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LED off seconds

Set a time in seconds after the device starts, after which the LED(s) of the device are switched off if the LED
mode is set to Timed-Off.

Syslog
For diagnostic purposes, the syslog of a LCOS LX-based device can be sent to an external syslog server.

The settings for this can be found under Management > Extended > Syslog.

Syslog

extemal Server...

Configure one or more syslog servers in the External Server table. Messages can be sent via TCP or UDP.

@ Note that syslog messages are unencrypted and may contain sensitive information about your network. For this
reason they should only be transmitted for diagnostic purposes over a secure network.

external Server - Mew Entry ? *
Port: 514
Protocal: TCP e
Cancel
Name

Name of the external syslog server.

IP address
IP address of the external syslog server.

Port
Port of the external syslog server.

Protocol
Protocol (TCP/UDP) used to communicate with the external syslog server.

4.1.5 802.1X supplicant

These are the settings for the 802.1X supplicant functionality, which authenticates the device towards the LAN at a
switch infrastructure secured by 802.1X. These are located under Management > 802.1X supplicant.

Use the 802.1X supplicant feature to autherticate the device to an 802.1X secured switch

infrastructure using the device's ethemet ports.

Configure 802.1X supplicant...
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Configuring the 802.1X supplicant

You configure the 802.1X supplicant functionality under Management > 802.1X supplicant > Configure 802.1X
supplicant.

Cenfigure 802.1X supplicant - Edit Entry ? X
Interface-MName: INTRAN
Method: none i
Cancel

Interface name
The name of the LAN interface. Currently there is only the interface INTRANET, and this cannot be changed.
Method
The EAP method used to authenticate at the 802.1X infrastructure.
User name
The user name to use to authenticate at the 802.1X infrastructure.
Password

The password to use to authenticate at the 802.1X infrastructure.

@ Support for authentication by means of client certificates will follow in a future LCOS LX version.

4.1.6 Software update

The LANCOM Auto Updater allows the automatic updating of on-site LANCOM devices without further user intervention.
LANCOM devices can search for new software updates, and download and install them without any user interaction.
You can choose whether to install security updates, release updates, or all updates automatically. If you choose not to
use automatic updates, the feature can still be used to check for the availability of new updates.

The LANCOM Auto Updater contacts the LANCOM update server to check for updates and firmware downloads.
Communication is based on HTTPS. When contacting the server, the LANCOM device uses previously installed TLS
certificates for validation. Furthermore, the firmware files for current LANCOM devices are signed. The LANCOM Auto
Updater validates this signature before uploading any firmware.
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The configuration for the LANCOM Auto Updater in LANconfig is located under Management > Software update.

Using the automatic LCOS-LX Software Update the device can check for new firmware versions
and install those matching the configured update policy during certain time frames.

Mode: Check & update ~
Check-Interval: daily ~
Version-Policy: latest version ~

Check time frame

From: |D |0'c|0ck

To: |D |0'c|0ck

Installation time frame

From: |2 |0'c|0ck
To: |4 | o'clock
Base-URL: |hﬂps:ffupdate.lancomﬂystems |
Mode

Set the operating mode here. The following modes are supported:

Check & update

> The Auto Updater reqularly checks the update server for new updates.

> The update server uses the update policy to find the most suitable update, it sets the time to download
and install the update within a time frame configured by the user, and it sends the update to the Auto
Updater.

> The firmware is installed in test mode. After installation, the Auto Updater performs a connection check.
Here, the device checks whether a connection can be established to the update server to ensure that
Internet access is still available. If the update server is contacted successfully, the test mode terminates
and the firmware goes into regular operation. If the update server cannot be contacted, then Internet
access is assumed to be impossible and the second (i.e. the previously active) firmware will be started
again.

Check

> The Auto Updater reqularly checks the update server for new updates.
> The availability of a new update is signaled to the user in the LCOS LX menu tree and via syslog.
> Users can manually use the Auto Updater to initiate the latest available update.

@ A manual update is started with the following entry on the command line:
do /setup/Automatic-Firmware-Update/Update-Firmware-Now
Manual

> The Auto Updater only checks for new updates when prompted by the user.
> Users can manually use the Auto Updater to initiate the latest available update.

@ A manual update is started with the following entry on the command line:

do /setup/Automatic-Firmware-Update/Update-Firmware-Now

Check interval
This decides whether checks for an available update are performed daily or weekly.
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Update policy

Latest version

Always the newest version, irrespective of the release version. Example: 10.20 Rel is installed; an update to
10.20 RU1 is performed, but also to 10.30 Rel. Updates always go to the latest version, but not back to a
previous release.

Current version

The latest RU/SU/PR within a release. Example: 10.20 Rel is installed; an update to 10.20 RU1 is performed,
but not to 10.30 Rel.

Security patches only

The latest SU within a release. Example: 10.20 Rel is installed; an update to 10.20 SU1 is performed, but not
to 10.20 RU2.

Latest version w/o REL

The newest RU/SU/PR, irrespective of the release version. Updates are only performed if a RU is available.
Example: Any version of 10.20 is installed; an update to 10.30 RU1 is performed, but not to 10.30 REL.

Check time frame

Set the time frame for checking and downloading new updates here. The daily start and end time for this
time frame can be set to the hour. The default value for both of these is 0, so checks for updates and downloads
can be started at any time of day. The Auto Updater schedules a random time for update checks and downloads
within the configured time frame.

Installation time frame

Set the time frame for update installations here. The daily start and end time for this time frame can be set
to the hour. The default setting specifies a time frame between 2:00 AM and 4:00 AM. If an update is found,
it will be installed during this time and the device will be restarted to activate the update. The Auto Updater
schedules a random time for the installation within the configured time frame.

Base URL
Specifies the URL of the server that provides the latest firmware versions.

4.2 Date/Time

The section Date/Time contains the corresponding device settings.

4.2.1 Configuration

The device settings date and time are to be found under Date/Time > Configuration.

Timezone

Timezone: uTc ~
NTP client
Operating: Mo ~

Timeframes

Time frames for the WLAN time control feature can be defined here.
Timeframes...

Holidays...
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Time zone

Set the correct time zone.

NTP client

Using the Network Time Protocol (NTP), the device can read the current time from a public time server on the Internet
(NTP server with an “open access” policy such as the Physikalisch-Technischen Bundesanstalt in Germany). LANCOM
routers also work as NTP servers, so not every network device needs to access an external NTP server.

Operation

Yes

The NTP server set under Server is used to set the date and time.
No

Do not use an NTP server.

Server

Enter the address of the NTP server.

Timeframes

Timeframes are used to switch individual SSIDs on and off according to a schedule. One profile may contain several rows
with different timeframes. Add the time frame to the logical WLAN settings for it to be used with the corresponding
SSID.

As an example, a number of timeframes have already been set up here to illustrate a configuration for a school day.
There are two timeframes with the same name “Lessons” — but with different start and stop times in order to allow a
45-minute break between these two timeframes. This is defined in the time frame “Break”. Timeframes can be restricted
to certain days of the week. Holidays are also taken into account as long as they are entered in the Holidays table.
Summertime/wintertime is also observed based on the time zone setting.

Predefined timeframes are ALWAYS and NEVER. You can configure additional timeframes in LANconfig under Date/Time >
Configuration > Timeframes. This section also allows you to specify public holidays for the timeframes.

Timeframes - New Entry ? X
Start: 00 : 00
Stop: 23:59
Weekdays

[ Sunday [IMonday ~ []Tuesday [ ]Wednesda
[ Thursday ] Friday [ Saturday [ Holiday

Cancel

Name

Enter the name of the time frame so that it can be referenced from the WLAN SSID. Several entries with the
same name result in a common profile.

Start

The start time (time of day) can be specified in the format HH:MM (default: 00:00), from which the selected
profile becomes valid.
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Stop
The stop time (time of day) can be specified in the format HH:MM (default: 00:00), from which the selected

profile ceases to be valid.

@ A stop time of HH:MM usually runs until HH:MM:00. The stop time 00:00 is an exception, since this
is interpreted as 23:59:59.

Weekdays
Here you select the weekday on which the timeframe is to be valid.
Possible values:
> Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, Sunday, Holiday

You can form a time schedule with the same name but with different times extending over several rows.

Holidays
Holidays - New Entry ? *
Date: [
Cancel

Enter the public holidays to be observed in the time frame.

@ The year 0 stands for any year.

4.3 IP configuration

The settings for the IP configuration of your device are located under IP Configuration > Configuration.

|IP-Configuration

MNetwork interfaces, including their addresses and settings like DHCP, are corfigured in this
table.

LAN-Interfaces...
‘When using static |P addresses, further Parameters can be configured in this table.

Static Parameters...
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4.3.1 LAN interfaces

36

Under IP Configuration > Configuration > LAN interfaces you can modify the basic configuration relating to the
device's own IP settings and network access.

LAN-Interfaces - Edit Entry ? X
Interface-MName:
Interface-1D:
IPv4 Address Source: DHCP ~
IPv6 Address Source: static ~

Static |Pv4 Address: 0.0.0.0-24

Static |Pv6 Address:
Cancel

Interface name

Set a meaningful name for the interface here. This name is used to reference the interface configuration from
other parts of the configuration.

Interface-ID
The internal identifier for the interface.
VLAN ID

Here you specify a VLAN ID for which the interface should be active and accessible. The default value “0”
means that no VLAN is used.

IPv4 address source
Here you select how the IPv4 address of the interface is to be obtained.
DHCP
The IP address is retrieved via DHCP.

Static
The static IP address configured for the interface is used.

IPv6 address source

Here you select how the IPv6 address of the interface is to be obtained:

Router-Advertisement

The IPv6 address is derived from router advertisements that the device receives on the respective interface.

@ If the flag in the router advertisement is set to Other and/or Managed, additional configuration options
are obtained via DHCPv6—even if the address source is set to Router-Advertisement.

DHCPv6
The IPv6 address is obtained via DHCPv6.

Static
The static IPv6 address configured for the interface is used.
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Static IPv4 address

Here you configure the IP address to be used when the IPv4-Address-Source is set to Static. Add the subnet
mask in CIDR notation (e.g. “/24") as a suffix.

Static IPv6 address

Here you configure the IP address to be used when the IPv6-Address-Source is set to Static. Add the subnet
mask in CIDR notation (e.g. “/64") as a suffix.

Comment

Here you can enter a comment about the interface configuration.

4.3.2 Static parameters

Other settings related to the IP and network configuration that are required when using static IP addresses are located
under IP Configuration > Configuration > Static parameters.

Static Parameters - Edit Entry ? X

Interface-MName: INTRANET

|IPv4-Gateway: 0.0.00

Primary |Pv4 DNS Server: |0.0.0.0

Sec. IPv4 DNS Server: 0.0.0.0

Primary IPv6 DNS Server: I:I

Sec. IPv6 DNS Server: I:I

Cancel

@ The settings made in this table only come into effect if the IPv4 or IPv6 address source for the corresponding
LAN interface is set to static. Otherwise all of the necessary information is retrieved via DHCP, for example, in
which case no configuration is required here.

Interface name

Enter the name of the interface, which the other settings made here refer to.
IPv4-Gateway

Here you configure the IPv4 gateway for the referenced interface.
IPv6-Gateway

Here you configure the IPv6 gateway for the referenced interface.
Primary IPv4 DNS server

Here you configure the primary IPv4 DNS gateway for the referenced interface.
Secondary IPv4 DNS server

Here you configure the secondary IPv4 DNS gateway for the referenced interface.
Primary IPv6 DNS server

Here you configure the primary IPv6 DNS gateway for the referenced interface.
Secondary IPv6 DNS server

Here you configure the secondary IPv6 DNS gateway for the referenced interface.
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4.4 Wireless LAN

In the section Wireless LAN you will find all the settings related to the broadcasting of WLAN networks.

4.4.1 WLAN networks

38

The wireless network settings for your device are located under Wireless LAN > WLAN networks.

General

The Country in which the device is operated can be configured here. Regulatory Limits will be
automatically set depending on the country setting.

Country: Europe ~

General

WLAN networks (5510s) and physical {radio) WLAN settings can be configured here.

Network...
Encryption...
Radio-Settings...
Rate-Selection...
Time Controlled Scan
Enabled: Yes i
Begin: 02 : 00
End: 02 : 53
In general
Country

Here you configure the country where the device is operated. Depending on this, the appropriate regulatory
limits are set automatically.
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Networks

General settings relating to the broadcast WLAN networks (SSIDs) are configured under Wireless LAN > > WLAN

Networks > Network. Add a line to the table for each WLAN network. By default, the table is empty.

MNetwaork - Mew Entry ? X
Network-Name: NETWORK]
S5ID-Name:
Key (PSK): [ Oshow

Generate password

Radios: 24+5GHz ~
Encryption-Profile: Select
Idle-Timeout:

T banduwidth limit: o kBus
Rx banduwidth limit: o kBus

Inter-Station-Traffic: Yes ~
Suppress 551D broadcast: | No -

Maximum client count: I:I
Minimal client signal str. I:I

Exclude From Client Mgmt: | No -
Timeframe: ALWAYS w Select
Block Multicast: Mo ~ Select

Clent Txbandwidthfimt: [0 |kBiss
Clent Rebandwidthlmit: [0 |kBiss

Cancel

Network-Name

Choose a meaningful name for the WLAN network here. This internal identifier is used to reference the
interface configuration from other parts of the configuration.

@ This is not the name of the SSID and is not displayed by the clients. This is configured in the next
step.

SSID-Name

Here you configure the name of the SSID to be broadcast. This name is displayed on the wireless clients when
searching for WLAN networks.

Key (PSK)

Configure the pre-shared key (PSK) used for the WLAN network here. If you select Show, you can use Generate
password to create a random password. Use the arrow next to it to set the strength, length and various
other settings for the characters used for the generated pre-shared key.

@ This entry only applies if an encryption profile using WPA(2)-PSK is selected. If 802.1X is used, the
entry has no effect and the field can be left blank.

Radios
Configure here the WLAN frequencies that the SSID is to be broadcast on.

2.4 GHz + 5 GHz
The SSID is broadcast on the frequencies 2.4 GHz and 5 GHz.
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2.4 GHz
The SSID is only broadcast on the 2.4-GHz frequency.

5 GHz
The SSID is only broadcast on the 5-GHz frequency.

none
The SSID will not be broadcast. This can be used as a general on/off switch for the SSID.

Encryption-Profile

Here you select an encryption profile that defines the authentication and encryption method used for the
SSID.

By default, the following encryption profiles are available for selection:

P-NONE
No encryption, the SSID is open.
P-PSK

The authentication method used is WPA2 with pre-shared key (PSK), also known as WPA2-Personal. A key
must be configured for the WLAN network.

P-PSK-WPA2-3

The authentication method used is WPA2 and/or WPA3 with pre-shared key (PSK), also known as WPA-Personal.
A key must be configured for the WLAN network.

P-PSK-WPA3

The authentication method used is WPA3 with pre-shared key (PSK), also known as WPA3-Personal. A key
must be configured for the WLAN network.

Idle-Timeout

This is the time in seconds during which the access point cannot receive any further packets after a client is
disconnected. The timeout is reset by any data traffic from the client.

TX bandwidth limit

Here you set a WLAN bandwidth limit that applies to the entire WLAN network. All of the logged in clients
can only receive data with the transmission rate configured here. The value “0” means that no limitation is
active. The transmission direction is considered relative to the access point, so “Tx"” means the transmission
rate from the access point to the client. This setting affects the download rate at the client.

RX bandwidth limit

Here you set a WLAN bandwidth limit that applies to the entire WLAN network. All of the logged in clients
can only send data with the transmission rate configured here. The value “0" means that no limitation is
active. The transmission direction is considered relative to the access point, so “Rx" means the transmission
rate from the client to the access point. This setting affects the upload rate at the client.

VLAN-ID

This VLAN ID is used to tag the data packets arriving from the WLAN and heading for the LAN. Similarly,
packets with this VLAN ID arriving from the LAN are directed to the WLAN and are de-tagged.

@ This operating mode corresponds to what is normally known as the “Access” tagging mode, since it
is assumed that wireless clients usually transmit data untagged. Tagging mode cannot be adjusted.
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Inter-Station-Traffic

Depending on the application, it may be required that the WLAN clients connected to an access point can—or
expressly cannot—communicate with other clients. Here you configure whether communication between the
WLAN clients on the WLAN network should be allowed.

Suppress SSID broadcast
Here you configure whether this SSID is displayed to clients searching for a network.

If the SSID broadcast is suppressed, the access point will not respond to probe requests with an empty SSID.
In this case, establishing a connection requires the SSID to be explicitly entered into and configured on the
client.

Maximum client count

This number determines the number of clients that can log on to the WLAN network simultaneously before
further requesting clients are rejected.

The value “0” means that there is no limit, so unlimited number of clients can be logged in at the same time
(up to a possible hardware-related limit).

Minimal client signal strength

Here you configure the minimum signal strength in percent that a client must “show” at the access point in
order for it to be able to connect to the WLAN.

The value “0" means that there is no minimum signal strength requirement and clients are always allowed
to connect.

Exclude From Client Management

This SSID may be exempted from the band steering.
Timeframe

Enter the name of a Timeframe here. This is used to schedule when this SSID is switched on or off.
Block Multicast

This can be used to block multicasts sent or received by WLAN clients. A distinction can be made between
IPv4 and IPv6.

@ ICMPv6 packets are not blocked in order for IPv6 address referencing to continue to work.

@ The LW-500 does not support this feature.

Client Tx bandwidth limit
Here you limit the bandwidth used by WLAN clients in the send direction.
Client Rx bandwidth limit

Here you limit the bandwidth used by WLAN clients in the receive direction.

Encryption

The settings for encryption and authentication on the WLAN networks are configured under Wireless LAN > WLAN
networks > Encryption. The following encryption profiles are stored by default and these can be used for the
configuration of the WLAN networks.

P-NONE
No encryption, the SSID is open.
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P-PSK

The authentication method used is WPA2 with pre-shared key (PSK), also known as WPA2-Personal. A key
must be configured for the WLAN network.

P-PSK-WPA2-3
The authentication method used is WPA2 and/or WPA3 with pre-shared key (PSK), also known as WPA-Personal.
A key must be configured for the WLAN network.

P-PSK-WPA3

The authentication method used is WPA3 with pre-shared key (PSK), also known as WPA3-Personal. A key
must be configured for the WLAN network.

Encryption - Mew Entry ? X

Profile-Name: P-PSK]

Encryption: Yes ~
Method: WPA(2/3)}-PSK ~
WPA-Version: WPAZ e

TKIP

WPAZ-3-Session-Keytypes: | AES ~
Encrypt manag. frames: Mo ~

TES

WPAZ-Key-Management: | Standard ~
SAE/OWE-Groups
DH-19 []oH-20
[]oH-21
PMK-APP-Secret: [ Oshow
Generate password
Select
Cancel
Profile name

Choose a meaningful name for the encryption profile here. This internal identifier is used to reference the
encryption profile from other parts of the configuration.

Encryption

Here you configure whether the WLAN network should be encrypted or if no encryption should be used (Open
Network).

Method
Here you configure the encryption method. The following methods are available:
WPA

> WPA(2/3)-PSK: WPA2 and/or WPA3 with pre-shared key (PSK), also known as WPA-Personal.
> WPA(2/3)-802.1X: WPA2 and/or WPA3 with 802.1X, also known as WPA-Enterprise

@ Note that 802.1X requires a RADIUS server profile to be specified as well.
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WEP

@ The WEP process no longer provides adequate security and should only be used to integrate legacy
clients that do not support a newer security method. If this is the case, we recommend that you isolate
the WEP clients in their own VLAN to keep them separate from the rest of the WLAN infrastructure.

WEP-40-Bits: WEP with 40-bits key length

WEP-104-Bits: WEP with 104-bits key length

WEP-128-Bits: WEP with 128-bits key length
WEP-40-Bits-802.1X: WEP with 40-bits key length and 802.1X

vV VvV VvV Vv

@ Note that 802.1X requires a RADIUS server profile to be specified as well.

> WEP-104-Bits-802.1X: WEP with 104-bits key length and 802.1X

@ Note that 802.1X requires a RADIUS server profile to be specified as well.

> WEP-128-Bits-802.1X: WEP with 128-bits key length and 802.1X

@ Note that 802.1X requires a RADIUS server profile to be specified as well.

WPA-Version

Wi-Fi Protected Access (WPA) is an encryption method. Here you configure the WPA version used for the
encryption methods WPA(2)-PSK and WPA(2)-802.1X. The following versions are available:

> WPAT: WPA version 1 is used exclusively.
> WPA2: WPA version 2 is used exclusively.
> WPA3: WPA version 3 is used exclusively.
> WPA1/2: Whether the encryption method WPA 1 or 2 is used depends on the capabilities of the client.
> WPA2/3: Whether the encryption method WPA 2 or 3 is used depends on the capabilities of the client.

WPA1-Session-Keytypes

Here you configure the session key type to be used for WPA version 1. This also influences the encryption
method used. The following types are available:

TKIP

TKIP encryption is used.

AES

AES encryption is used.

TKIP/AES

Whether the encryption method TKIP or AES is used depends on the capabilities of the client.

@ Employing TKIP is only recommended for operating older WLAN clients which do not support AES.

@ If a WLAN network uses only WEP or WPA with TKIP for encryption, the WLAN clients connected to
it achieve a maximum gross data rate of 54 Mbps.

WPA2/3-Session-Keytypes

Here you configure the session key type to be used for WPA version 2 and 3. This also influences the encryption
method used. The following types are available:
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TKIP

TKIP encryption is used.

AES

AES encryption is used.

TKIP/AES

Whether the encryption method TKIP or AES is used depends on the capabilities of the client.

@ Employing TKIP is only recommended for operating older WLAN clients which do not support AES.

@ If a WLAN network uses only WEP or WPA with TKIP for encryption, the WLAN clients connected to
it achieve a maximum gross data rate of 54 Mbps.

Encrypt management frames

By default, the management information transmitted on a WLAN for establishing and operating data
connections is unencrypted. Anybody within a WLAN cell can receive this information, even those who are
not associated with an access point. Although this does not entail any risk for encrypted data connections,
the injection of fake management information could severely disturb the communications within a WLAN cell.

The IEEE 802.11w standard encrypts this management information (protected management frames, PMF),
meaning that potential attackers can no longer interfere with the communications if they don't have the
corresponding key.

@ As of WPA3, management frames have to be encrypted, so this value is ignored there and is assumed
to be set as “Mandatory”. For WPA2, this is optional.

WPA-Rekeying-Cycle

A 48-bit long initialization vector (V) impedes attackers in their attempts to calculate the WPA key. WPA also
introduced the use of a new key for every data packet (per-packet key mixing and re-keying). The actual key,
that consists of the IV and WPA key, is only repeated every 16 million packets. In high-traffic WLANS, the key
is repeated only after several hours. To avoid repetition of the key, WPA automatically renegotiates the key
at regular intervals. This avoids the repetition of the actual key.

Here you configure the time in seconds after which the access point performs rekeying when operating a
version of WPA.

The standard value is “0" and the key is not negotiated in advance.

Pre-authentication

Fast authentication by means of the Pairwise Master Key (PMK) only works if the WLAN client was logged on
to the access point previously. The WLAN client uses pre-authentication to reduce the time to logon to the
access point at the first logon attempt.

Usually, a WLAN client carries out a background scan of the environment to find existing access points that
it could connect to. Access points that support WPA2/802.1X can communicate their pre-authentication
capability to any WLAN clients that issue requests. A WPA2 pre-authentication differs from a normal 802.1X
authentication as follows:

> The WLAN client logs on to the new access point via the infrastructure network, which interconnects the
access points. This can be an Ethernet connection or a WDS link (wireless distribution system), or a
combination of both connection types.

> A pre-authentication is distinguished from a normal 802.1X authentication by the differing Ethernet
protocol (EtherType). This allows the current access point and all other network partners to treat the
pre-authentication as a normal data transmission from the WLAN client.
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> After successful pre-authentication, the negotiated PMK is stored to the new access point and the WLAN
client.

@ The use of PMKs is a prerequisite for pre-authentication. Otherwise, pre-authentication is not
possible.
> When the client wants to connect to the new access point, the stored PMK significantly accelerates the
logon procedure. The further procedure is equivalent to the PMK caching.

WPA2 key management
Here you specify which standard the WPA2 key management should follow. Possible values:

Standard

Enables key management according to the [EEE 802.11i standard without Fast Roaming and with keys based
on SHA-1. Depending on the configuration, the WLAN clients in this case must use opportunistic key caching,
PMK caching or pre-authentication.

Fast roaming

Enables fast roaming according to the IEEE 802.11r standard. See also Fast roaming on page 13.

@ Fast roaming is possible between devices based on LCOS and LCOS LX.

Standard+Fast-Roaming

Combination of standard and fast roaming

@ Although it is possible to make multiple selections, this is advisable only if you are sure that the clients
attempting to login to the access point are compatible. Unsuitable clients may refuse a connection if
an option other than Standard is enabled.

SAE/OWE groups

Contains the selection of the available Diffie-Hellman groups used by the protocol partners to create a key
for exchanging data. The available groups use elliptical curves.

The authentication method SAE (Simultaneous Authentication of Equals) used by WPA3 uses these methods
together with AES to generate a cryptographically strong key.

DH-19
256-bit random ECP group
DH-20
384-bit random ECP group
DH-21
521-bit random ECP group

PMK-IAPP-Secret

This passphrase is used to implement encrypted opportunistic key caching. This is required to use Fast Roaming
over IAPP. Each interface must be assigned an individual IAPP passphrase in the WLAN connection settings.
This is used to encrypt the pairwise master keys (PMKSs). Access points that share a matching IAPP passphrase
(PMK-IAPP secret) are able to exchange PMKs between one another and ensure uninterrupted connections.
You should therefore ensure that this passphrase is identical on all of the access points that should operate
fast roaming.
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RADIUS Server Profile

Here you configure the RADIUS server profile used when operating 802.1X. No input is required when using
PSK-based encryption methods. The profiles are created under RADIUS on page 49.

Radio settings

Settings relating to the physical radio parameters are configured under Wireless LAN > WLAN networks > Radio
settings. By default, there is an entry in the table for every physical WLAN radio for modification as required.

Radio-Settings - Edit Entry ? X
Interface: WLAN-1
Radio-Band: 24GHz
Auto
Band-1+2
Channel: I:I
2.4 GHz-Mode: Auto w

No

Max.Channel-Bandwidth: | Auta w
Power-Setting: Automatic ~
Cancel
Interface

The internal name of the WLAN radio. This cannot be changed.
Radio band
Shows whether this interface is operating in the 2.4-GHz or 5-GHz frequency range.

5-GHz mode

Here you configure the mode used for 5-GHz radio operation. This directly affects the available data rates. If
a restriction is set here, a client attempting to login triggers a check to see whether the modes used by the
client match with those configured here. Depending on this, the login is allowed or denied. The following
modes are available:

Auto
All modes supported by the device are used.

11an-mixed
The modes 802.11a and 802.11n are used.

11anac-mixed
The modes 802.11a, 802.11n and 802.11ac are used.

11nac-mixed
The modes 802.11n and 802.11ac are used.

11ac-only
Only the 802.11ac mode is used.

11anacax-mixed
The modes 802.11a, 802.11n, 802.11ac and 802.11ax (Wi-Fi 6) are used.
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@ Maximum compatibility and performance is available by setting the mode to Auto.

Sub-Band

Here you configure which sub-bands are used in the 5-GHz mode. The following sub-bands are available:

Band-1
Only sub-band 1 is used. This corresponds to the WLAN channels 36, 40, 44, 48, 52, 56, 60 and 64.
Band-2

Only sub-band 2 is used. This corresponds to the WLAN channels 100, 104, 108, 112, 116, 132, 136 and
140.

Band-1+2
Both sub-band 1 and sub-band 2 are used.

@ WLAN channels 120, 124 and 128 are not used because these channels are reserved for the primary
user RADAR.

Channel
Here you configure the channel to be used for WLAN radio operations.

The value “0" allows the automatic selection of a suitable channel.

@ In 5-GHz mode, the channel set here represents a preferred channel. However, since the 5-GHz band
requires the use of Dynamic Frequency Selection (DFS), there is no guarantee that the preferred
channel will actually be used.

2.4-GHz mode

Here you configure the mode used for 2.4-GHz radio operation. This directly affects the available data rates.
If a restriction is set here, a client attempting to login triggers a check to see whether the modes used by the
client match with those configured here. Depending on this, the login is allowed or denied. The following
modes are available:

Auto

All modes supported by the device are used.

11bg-mixed

The modes 802.11b and 802.11g are used.

11g-only

Only the 802.11g mode is used.

11bgn-mixed

The modes 802.11b, 802.11g and 802.11n are used.
11gn-mixed

The modes 802.11g and 802.11n are used.

11bgnax-mixed

The modes 802.11b, 802.11g, 802.11n and 802.11ax (Wi-Fi 6) are used.
11gnax-mixed

The modes 802.11g, 802.11n and 802.11ax (Wi-Fi 6) are used.

@ Maximum compatibility and performance is available by setting the mode to Auto.
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Channel List

Here you configure a comma-separated list of further WLAN channels. Automatic channel selection selects a
channel from this list, rather than from the full range of supported WLAN channels.

Exclude DFS channels

Here you configure whether to use channels in the 5-GHz band that require Dynamic Frequency Selection
(DFS).

If these channels are excluded here, the channels still available in the 5-GHz band are 36, 40, 44 and 48.
Since DFS is not required for these channels, they can be set with the option Exclude DFS channels in the
radio channel and also in the Channel list.

Max. channel bandwidth

Here you configure the maximum allowed channel bandwidth. The following settings are available:

Auto

For a 2.4-GHz radio the channel bandwidth of 20 MHz is always used. For a 5-GHz radio the maximum possible
channel bandwidth (up to 160 MHz) is always used, depending on the environment.

20 MHz

The channel bandwidth is always 20 MHz.

40 MHz

Depending on the environment, channel bandwidth is up to 40 MHz, but this can also fall back to 20 MHz.
80 MHz

Depending on the environment, channel bandwidth is up to 80 MHz, but this can also fall back to 40 MHz
or 20 MHz.

160 MHz

Depending on the environment, channel bandwidth is up to 160 MHz, but this can also fall back to 80 MHz,
40 MHz or 20 MHz.

Antenna gain

Where the transmission power of an antennae exceeds the levels permitted in the country of operation, the
power must be attenuated accordingly. Here you enter the gain of the antenna minus the actual cable loss.
For an AirLancer Extender O-18a antenna with a gain of 18 dBi and a 4 m cable with a loss of 1 dB/m, the
‘Antenna gain' would be entered as 18 - 4 = 14. This value for true antenna gain is dynamically used to
calculate and emit the maximum permissible power with regards to other parameters such as country, data
rate and frequency band.

@ Available for devices with external antennas only.

Power setting

This setting regulates whether to use the maximum permitted transmission power that the access-point
hardware can achieve (“Automatic”) or to specify the desired target transmission power in manual mode
(“Manual”). This is done in dBm in the field TX Power.

TX Power

Depending on the setting in the field Power setting, you set the transmission power in dBm here.

@ If the hardware of the access point is not capable of the desired transmission power, the maximum
possible value is set automatically.
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@ Under no circumstances will the access point exceed the regulatory limits for transmission power.
These are always respected automatically, regardless of the settings made here.

Rate selection

Increasing the broadcast and multicast data rates can help to reduce the load on the medium. Broadcasts and multicasts
are usually sent at the lowest possible rate in order to reach distant clients; however, this means that they occupy a large
slice of medium time. Adjusting this setting can be particularly useful in large networks with a high density of access
points.

Configure the broadcast and multicast data rates under Wireless-LAN > WLAN-Networks > Rate-Selection.

Rate-Selection - Mew Entry ? *
Metwork-MName: NETWORK w Select
Radioband: 24+5GHz ~
Broadcast-Rate: default ~
Mutticast-Rate: default ~

Cancel

Network name

The network or SSID to which the rates configured here should apply. The name must match with a name of
a network set up in Networks on page 39.

Radio band

The band that the rates configured here apply to. This can be further limited to a specific band.
Broadcast-Rate

The rate to use for sending broadcasts.
Multicast-Rate

The rate to use for sending multicasts.

4.4.2 RADIUS

The settings for RADIUS server profiles when operating WLAN networks that use 802.1X as the authentication method
can be found under Wireless LAN > RADIUS.

RADIUS-Server-Settings

RADIUS Server Profiles for usage with 802.1X-encrypted WLAN networks can be corfigured
here.

RADIUS-Server...
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Configure the RADIUS server profiles in the RADIUS server table.

RADIUS-Server - Mew Entry ? *
Port: 1812
St I

Server-IP-Address: I:I
Accourting-Port:
Accourting-|P-Address: I:I
Backup profile: I:I

RADIUS-MAC-Check: No ~

Cancel

Name

Choose a meaningful name for the RADIUS server profile here. This internal identifier is used to reference the
RADIUS server profile from other parts of the configuration.

Port
Select the port (UDP) used to contact the RADIUS server.

@ This is usually the port 1812 (RADIUS authentication).

Secret

Here you configure the secret used to encrypt the traffic between the device and the RADIUS server. This
secret must also be stored on the RADIUS server.

Server IP address
Here you configure the host name or IP address where the RADIUS server is to be reached.
Accounting port

Select the port (UDP) used to contact the RADIUS accounting server.

@ This is usually the port 1813 (RADIUS accounting).

Accounting IP address
Here you configure the host name or IP address where the RADIUS accounting server is to be reached.
Backup profile

Here you configure a backup profile, which will be used if the RADIUS server in the profile configured here
cannot be reached.

RADIUS-MAC-Check

A user name can be authenticated with a MAC address instead of using the RADIUS server.

Dynamic VLAN for 802.1X

The RADIUS server uses dynamic VLAN to assign a VLAN ID to the WLAN client for 802.1X authentication. This assigns
clients to the required VLAN without the need to operate a separate SSID for each VLAN.

The RADIUS server must send the following attributes in the accept message:
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ID Name Meaning Possible values in LCOS LX
64 Tunnel-Type Defines the tunneling protocol which will be used for the 13 (VLAN)
session.
65  Tunnel-Medium-Type Defines the transport medium over which the tunneled session 6 (IEEE 802)
will be established.
81 Tunnel-Private-Group-ID Specifies a required VLAN ID. 1-4096

4.4.3 Client Management

The band steering settings for Wi-Fi networks can be found under Wireless LAN > Client Management.

WLAN Client-Management Settings
WLAN Client-Management profiles can be corfigured here.

Active-Profile: P-DEFALULT] - Select

Profiles...
2.4GHz-5ub-Profiles....
5GHz-5ub-Profiles...

Active profile

Here you select the profile with the settings for the band-steering module.

P-DEFAULT

Steering is based on the load on the medium and the interference detected on the current channel and is
preferably performed with 802.11v. If the client does not support 802.11v, steering is induced by deliberately
disassociating the client. Steering can be performed before association and, if necessary, once the client is
already associated. This is the recommended profile.

P-DISABLED
No steering is performed. The client decides independently which frequency band to use.

P-LEGACY

Steering is performed before the client associates by deliberately withholding probe responses. Regardless
of the load, the 5-GHz band is always preferred.

Profiles

Adjust the detailed settings of the steering profiles or create a new profile under Wireless LAN > Client Management >
Profiles.
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@ LANCOM recommends using the preset profiles.

Profiles - New Entry ? X
Profile-Name: P-DEFALILT]
Operating: Yes ~
Steering Min PHY Signal:
Upgrade TX Rate Thresh. |50000
Upgr. PHY Signal Thresh.
Downgr. TX Rate Thresh. |6000
Downgr. PHY Sig. Thresh. I:I
2 4GHz Sub Profile: P-DEFAULT w~ Select
5GHz Sub Profile: P-DEFAULT w~ Select
Cancel
Profile name

Give this profile a name.
Operation

Controls whether band steering is active for this profile.
Steering min. PHY signal

Specifies the client signal strength (in dB) below which client steering is initiated.
Upgrade TX rate threshold

Specifies the limit value of the transmission rate (in kbps), at which the client should potentially be steered
to the 5-GHz band.

Upgrade PHY signal threshold

Specifies the client signal strength (in dB) required as a minimum before the client is considered for steering
to the 5-GHz band.

Downgrade TX rate threshold

Specifies the limit value of the transmission rate (in kbps), at which the client should potentially be steered
to the 2.4-GHz band.

Downgrade PHY signal threshold

Specifies the client signal strength (in dB) that must be exceeded before the client is considered for steering
to the 2.4-GHz band.

For steering to 2.4 GHz (downgrade), the signal strength has to fall below the value configured here and also
below the Downgrade TX rate threshold value.

2.4-GHz sub-profile
Here you configure which 2.4-GHz sub-profile is used.
5-GHz sub-profile

Here you configure which 5-GHz sub-profile is used.
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2.4-GHz sub-profiles

The settings for the 2.4-GHz sub-profiles are located under Wireless LAN > Client Management > 2.4GHz sub-profiles.

2.4GHz-5ub-Profiles - Mew Entry ? X

Profile-Name: P-DEFALLT]
Utilization-Check-Interval: (10

Lkilization Average Period:
Util. Overload Threshold: |70

Util. Deviation Threshold: |50

Interference Detection: Yes ~
Delay Probe Si Thresh. 5!
Delay Probe Time Window:

Delay Min Request Count:

1

oK Cancel

Profile name

Give this 2.4-GHz sub-profile a descriptive name.
Utilization check interval

Configures the interval (in seconds) for checking media utilization.
Utilization average period

Configures the period (in seconds) over which the media utilization is averaged. This value must always be
higher than the value configured for the Utilization check interval.

Utilization overload threshold

Configures the media utilization (in percent) above which the current 2.4-GHz channel is assumed to be
overloaded.

Utilization deviation threshold

Configures the media utilization (in percent) which, together with the expected media utilization, may be
reached before any further downgrade steering is stopped (until the next measurement of medium utilization).

Interference detection
Configures whether interference on the configured 2.4-GHz channel is considered for steering decisions.

Delay probe signal threshold

Specifies the client signal strength (in dB) that must be reached before steering-related probe responses are
delayed.

Delay probe time window

Configures the time window (in seconds) in which a client must receive at least the number of probe requests
configured under Delay min. request count before it responds to them.

Delay min. request count

Configures the number of probe requests that a client must receive within the period configured under Delay
probe time window before it responds to them.
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5-GHz sub-profiles

The settings for the 5-GHz sub-profiles are located under Wireless LAN > Client Management > 5 GHz sub-profiles.

5GHz-Sub-Profiles - New Entry ? X

Profile-Name: P-DEFALLT]

Utilization-Check-Interval:

Lkilization Average Period:

Util. Overtoad Threshold:

Ltil. Deviation Threshold:

Interference-Detection: Yes ~

Cancel

Profile name

Give this 5-GHz sub-profile a descriptive name.
Utilization check interval

Configures the interval (in seconds) for checking media utilization.
Utilization average period

Configures the period (in seconds) over which the media utilization is averaged. This value must always be
higher than the value configured for the Utilization check interval.

Utilization overload threshold

Configures the media utilization (in percent) above which the current 5-GHz channel is assumed to be
overloaded.

Utilization deviation threshold

Configures the media utilization (in percent) which, together with the expected media utilization, may be
reached before any further downgrade steering is stopped (until the next measurement of medium utilization).

Interference detection

Configures whether interference on the configured 5-GHz channel is considered for steering decisions.

4.4.4 Stations/LEPS

54

The configuration of the Profiles and Users for LANCOM Enhanced Passphrase Security (LEPS) are located in LANconfig
under Wireless LAN > Stations/LEPS > LEPS. The switch LEPS active enables the LEPS feature.

LEPS

Using LEPS {LANCOM Enhanced Passphrase Security), user-defined WLAN passphrases can
be assigned to WLAN stations and, optionally, bound to a MAC address. LEPS can also be
used as a MAC address filter.

LEPS active: No w

Profiles... Users...

When configured in LEPS, each user who should be able to authenticate client devices on the WLAN receives an individual
passphrase. LEPS profiles are used to avoid having to repeat all of the settings for every new user. You then create the
LEPS users with their individual passphrases and link them to one of the LEPS profiles created previously.

Alternatively, you can link the passphrase to a MAC address to set up a MAC address filter.

@ For technical reasons, LEPS is only compatible with WPA version WPA2.
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@ Note that with WPA2/3 encryption mode, the client can use both WPA versions, which can lead to unexpected

behavior when used with LEPS.

Profiles

Configure LEPS profiles here and link them to an SSID. You can then assign the LEPS profiles to the LEPS users.

fi\ The setting "Whitelist" only permits stations whose MAC

= address is corfigured in the User-Table. "Blacklist” only
permits stations whose MAC address is not configured in the
User-Table. The setting "Disabled” causes the MAC address
to be ignored for the LEPS association of the station.
However, any user-specific passphrase that may have been
set is still taken into account.

Cancel

Profiles - New Entry ? X
Check MAC Address: Disabled i
wan CR—

Name

Enter a unique name for the LEPS profile here.

Network name

Here you select the SSID or, in the case of a WLC, the logical WLAN network for which the LEPS profile applies.
The only users who can authenticate at the SSID or, in the case of a WLC, at the logical WLAN network are

those who are connected to it via the LEPS profile.

Check MAC address

Possible values:

Disabled

The MAC address plays no role during LEPS authentication. If any user-specific passphrase has been set, this

will be checked.
Whitelist

Only clients whose MAC address is known are admitted.

Blacklist

Only clients whose MAC address is not known are admitted.

VLAN

Here you specify which VLAN is assigned to a LEPS user or client who is connected to this profile.

Users

Create individual LEPS users here. Each LEPS user must be linked with a previously created profile and assigned an
individual WPA passphrase. Any client can then use this passphrase to authenticate at the SSID specified in the
corresponding profile. The passphrase identifies the user, who is assigned to the VLAN specified in this table. If no VLAN
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is specified here, the user is assigned to the VLAN configured in the profile. Settings for the individual user thus take
priority over settings in the profile.

Users - Mew Entry ? X
- s
WPA-Passphrase: I:I [ Show

Generate password
wessm [ ]
wa —
Cancel
Name

Enter a unique name for the LEPS user here.
Profile

Select the profile for which the LEPS user is valid. The only LEPS users who can authenticate at the SSID are
those who are connected to it via the LEPS profile.

WPA-Passphrase
Here you can specify the passphrase to be used by LEPS users to authenticate at the WLAN.

@ The passphrase can be a string of 8 to 64 characters. We recommend that the passphrases consist
of a random string at least 32 characters long.

MAC-Address

Optionally specify a MAC address for a MAC filter. The setting in the profile decides whether this entry is
ignored or whether the client devices listed in this table only are able to log on (whitelist). Using a blacklist,
the MAC filter works the other way round: the specified MAC addresses cannot log on.

Compared to simply assigning a passphrase to a user, managing a passphrase for each MAC address requires
a bit more work, but you have greater control over the devices in the network.

VLAN

Here you specify which VLAN is assigned to the LEPS user. If no VLAN is configured here, the VLAN configured
in the LEPS profile (if any) applies. If a VLAN is configured in both the LEPS profile and for the LEPS user, the
VLAN configured here takes priority.

4.4.5 WLC

LCOS LX-based access points can be managed by a LANCOM WLAN controller (WLC). Like LCOS-based access points,
they use the CAPWAP protocol.

@ The prerequisite for this is a LANCOM WLAN controller with LCOS version 10.40 or higher.

@ For background information on WLAN management with LANCOM WLAN controllers, see the section “WLAN
management” in the LCOS reference manual.

In their factory default settings, LCOS LX-based access points search the local network for a WLAN controller. They also
query the DNS name “WLC-Address” to try to reach a WLAN controller.

@ An access point will not try to contact the LANCOM Management Cloud if it is already being managed by a WLC.
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@ If the access point is managed by the LANCOM Management Cloud and a WLAN configuration is rolled out to
the access point by the LMC in this context, the access point will no longer attempt to contact a WLC.

This make it possible to use zero-touch commissioning, which means that no further configuration of the access point
is necessary. A manual configuration may still be necessary in certain circumstances. This can be done using LANconfig
in the device configuration under Wireless LAN > WLC.

WLAN-Management

Operating with WLC: No -
Port: [1027 |
Update cerificate before: |31] |da=,'5

In this table you can specify the primarily to be used WLAN controllers (WLCs) for the
mananged access point (AF). f access point and WLAN controller are located in the same [P
network a configuration is not required hre.

WLAN Controller...

Operating with WLC
This configures whether an access point actively searches for a WLC and can be managed by one.

@ This option should be deactivated for operation in stand-alone mode.

Port

Configures the port used to attempt to reach a WLC. The default value of 1027 is the default port used by
the CAPWAP protocol. By default, LANCOM WLCs also use this port.

Update certificate before

Configures how many days before its expiry that the device certificate used by the access point to authenticate
at the WLC is renewed.

WLAN Controller

Configures user-specified WLAN controllers. This may be necessary if a WLC cannot be found via the local
network (e.g. with routed connections) and also the DNS name “WLC-Address” cannot be used to inform the
access point about the address of the WLC.

Supported features
LCOS LX supports the following features for WLC operations:

Area Feature Supported?

In general Password synchronization Yes
WLC tunnel No
WLAN scheduling Yes

Logical WLAN configuration VLAN tagging Yes
WPA2 Yes
WPA3 Yes
Enhanced Open Yes
Enhanced Open Transitional No
802.1X Yes
RADIUS profile Yes
Standalone mode Yes
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Area Feature Supported?
802.11u/Hotspot 2.0 No
0KC No
MAC check Yes
RADIUS accounting Yes
Inter-station traffic Yes
Fast roaming Yes
Base rate adjustable No
Client bridge support No
Bandwidth limitation per SSID Yes
Bandwidth limitation per client No
Maximum count of clients Yes
Min. client signal strength Yes
Client disassociation signal strength No
LBS No
Convert to unicast No
Transmit only unicasts No
U-APSD Activated

permanently
Encrypt mgmt frames Yes

Physical WLAN parameters Country setting Yes
Configure 2.4-GHz mode Yes
Configure 5-GHz mode Yes
Configure 5-GHz sub-bands Yes
Set DTIM period No
Set the background scan interval No
Set antenna gain Yes
Set TX power reduction No
Activate the VLAN module ' -
ARC: Client steering Yes ?
ARC: Adaptive RF Optimization No
Enable QoS according to 802.11e (WME) Activated

permanently
Indoor-only mode activated Yes
Report seen unknown clients No

! Unnecessary with LCOS LX.
2 Currently, only AP-based band steering is supported. The settings Preferred frequency band and Probe request age-out time
have no influence.
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Area Feature Supported?

General/profile Specify alternative WLCs No
Configuration delay No
LED profiles Yes
Wireless ePaper No
Wireless IDS No
AutoWDS No
IP parameter profiles Yes
Firmware management Yes
Script management No
LEPS-U Yes
LEPS-MAC Yes
Assignment of a VLAN ID via LEPS-MAC (Dynamic VLAN) Yes
ARC: RF optimization No

4.5 10T — the Internet of Things

Here you will find the settings for loT technologies supported by LCOS LX, such as Wireless ePaper and Bluetooth Low
Energy.

loT networks interconnect physical and virtual objects to facilitate the exchange of data and information. Typical examples
include sensors, smart home appliances, digital room signs, and electronic shelf labels. loT devices are largely networked
by radio, using a variety of wireless technologies such as modified ZigBee variants (retail loT), Bluetooth Low Energy
(BLE), or the various cellular offshoots. There is no uniform “loT wireless standard”, and new loT radio technologies are
emerging in rapid cycles.

The specific settings for loT are made in LANconfig under loT.

4.5.1 Wireless ePaper

LANCOM Wireless ePaper Displays provide a variety of options for displaying information. You can automatically and
remotely update the calendar schedule for your conference rooms, you can create dynamic notices and direction signs,
or you can control the price labels of goods on your shelves from a central location in real time. The wide range of
different settings allows you to set up your very own customized use case.

The settings for operating Wireless ePaper Displays are to be found in LANconfig under Tools > Options > Wireless
ePaper. Under IP/hostname you enter the IP address and the port of the Wireless ePaper Server. The recommended port
number is 8001.

You invoke the Wireless ePaper management in LANconfig under Tools > Start Wireless ePaper management.

Settings for Wireless ePaper

Wireless ePaper Displays from LANCOM offer state-of-the-art digital signage for a wide range of applications. The Displays
are controlled by an innovative wireless technology with extremely low power consumption.

@ ePaper operations require the use of a USB-connected LANCOM Wireless ePaper USB expansion module for each
device.
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Activate the Wireless ePaper radio module in LANconfig under loT > Wireless ePaper,

Wireless ePaper

Operating: No ~

Wireless ePaper Server

Server Address: l:l
Server Port: 7.354

Pratocal: ThinAP2.0/TLS ~
Server Authentication: No ~
Server Hostname Verffication: Mo ~

Channel selection

Channel: Channel 0 (2404 MHz) ~

Depending on the used Wireless ePaper radio channel, the connection to the server may take
up to 30 minutes (applies for channel 3. 5. 8, 5. 10) and up to 120 minutes (applies for channel
0.1.2.467).

fi“\ To uge the Wireless ePaper function with LX-6400 series access points, a LANCOM
57 Wireless ePaper LISB expansion module must be connected.

Operation

Use this to activate the Wireless ePaper feature in the access point.

®

The server must be configured for the connection type ThinAP2.0/TCP. Please refer to the LANCOM
Support Knowledge Base for further information. Use the same method to set the following two
configuration options to enable communication between the server and LCOS LX access points:

accessPointUseThinMode?value=true
accessPointThinUseOutboundMode?value=true

This can be done, for example, with “curl” as follows:

curl -X PUT http://localhost:8001/service/configuration/accessPointUseThinMode?value=true
curl -X PUT http://localhost:8001/service/configuration/accessPointThinUseOutboundMode?value=true

@ The legacy connection mode via UDP is not supported by LCOS LX.

Server address

Here you configure the IP address of the Wireless ePaper Server that the access point should contact.
Server port

The TCP destination port to be used for communication with the server.
Protocol

The protocol used to communicate with the server.
Server Authentication

Optionally, the access point can check the server certificate of the Wireless ePaper Server when it connects
to it. If this option is enabled, a corresponding CA certificate (or certificate chain) in PEM format must also
be loaded onto the access point via WEBconfig.

Server Hostname Verification

In connection with the Server Authentication option, this setting decides whether the “Common Name”
specified in the certificate is checked for a match with the host name of the addressed Wireless ePaper Server.

Channel

Configure the radio channel to be used for controlling the Wireless ePaper Displays.

®

Depending on the radio channel used, connecting the server to a Display can take up to 30 minutes
(channels 3, 5, 8, 9, 10) or up to 120 minutes (channels 0, 1, 2, 4, 6, 7). If possible, you should prefer


https://support.lancom-systems.com/knowledge/pages/viewpage.action?pageId=36453517
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the channels 3, 5, 8, 9 and 10, as Wireless ePaper Displays scan them more frequently and they do
not interfere with the popular Wi-Fi channels 1, 6, and 11.

Output Power
[mw]

- Frequency
——— Wireless ePaper Channels Recommended Channels [MHz]

—— WLAN Channels ——— Altenate Channels

@ Do not select the same channel for two access points that are in the same area. This causes interference
and prevents Displays from joining the network. It is possible to set the same channel on two access
points if you are sure that each display is only within range of one of these access points.

4.5.2 Bluetooth Low Energy (BLE)

The settings for Bluetooth Low Energy are located here.

The specific settings for BLE are made in LANconfig under loT > Bluetooth LE.

BLE

Operating: Mo ~
BLE Scan Type: Passive ~
Operation

By turning on the BLE radio here, data about the BLE environment is collected continuously.

BLE Scan Type

Choose between a passive and an active scan. The BLE name and a scan response can only be detected in
the active scan. Note that BLE clients answering scan requests can increase power consumption.

4.6 Other services

This item contains the settings for services supported by the LCOS LX, such as Location Based Services.

4.6.1 Location-based services (LBS)

LANCOM access points are able to work as LBS clients with an LBS server. In this case, they report any BLE clients within
range to the LBS server, which can then offer location-based services to those clients. As of LCOS LX 5.30, an HTTP
interface is supported.

Using the HTTP interface, access points can send LBS data directly to a freely configurable HTTP endpoint. The data is
sent in JSON format, which ensures easy processing at the receiving end.
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LANconfig: Miscellaneous Services > Location Based Services

HTTP Interface

Configure one or more web servers, to which the AP should periodically send BLE scan data.

HTTP-Server...

fi“\ Forthe AP to continuously acquire BLE scan data, activate the BLE operation in the menu
“S "IoT -» Blustooth LE".

@ In order for the access point to collect BLE data, the BLE feature has to be switched on separately. Please refer
to Bluetooth Low Energy (BLE) on page 61 or Location based services on page 83.

HTTP-Server
Under HTTP-Server you configure the HTTP endpoints for the LBS data.

HTTP-Server - New Entry ? X

- —

Data-Sources
BLE

BLE-Measurements-Fields

[ BLE address type

[[] BLE advertising data
[]BLE name

[] BLE single strength{RSSI)
[ BLE scan response data

Buffering Timeout: I:I seconds
e s C—

Cancel

URL
Configure the URL of the HTTP endpoint here.

@ HTTP and HTTPS are supported. If you use HTTPS, a CA certificate for server verification must also be
uploaded to the device. This can be done using WEBconfig. See Location based services on page 83.

Secret

The secret (key) is transmitted from the access point to the end point in the JSON messages and can additionally
be used for message authentication.

Data-Sources
Here you configure the types of LBS data that should be sent. Only BLE is currently available.
BLE-Measurements-Fields

Here you configure which measurement fields or data from the access point should be included in the messages
to the HTTP endpoint. In order to minimize the data volume, we recommend that you limit this to essential
data only.

Buffering Timeout

After the configured time (in seconds) is reached, all BLE messages buffered up to that point are sent to the
server.
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Buffer Size

After the configured data quantity (in bytes) is reached, all BLE messages buffered up to that point are sent
to the server.

@ With the value for Buffering Timeout and Buffer Size both set to 0, the messages are sent to the
server as soon as possible.

Data format of the messages sent to the endpoint

> For BLE:
{
"deviceMac": "00A0574C49EB",
"measurements": [
{
"addressType": "Random",
"deviceAddress": "70CE7B7014EC"
"name": "",
"rssi": -93,
"seenTime": 1599208076493
by
{
"addressType": "Random",
"deviceAddress": "70CE7B7014EC",
"name": "",
"rssi": -93,
"seenTime": 1599208076494
"advertisingData": "1eff0600010920024bab81ba8815c5dc61c38449a886740alddb09b9e2ad8e”,
"scanResponseData": "050974657374"
}
1,
"secret": "",
"type": "BLE",
"version": "1.0"
}
version

The version of the API being used. Currently this is always 1.0.
secret

The HTTP server secret specified in the access point configuration.
type

The type of data sent. Can be either WLAN or BLE.

deviceMac
The LAN MAC address of the access point.

measurements
This contains at least one measured value. This could also be a number of measurements.

deviceAddress
The address of the BLE device or client.

seenTime
The time stamp (in Unix time) when the BLE frame from the client was received by the access point.

addressType
The type of BLE address. The following address types are available: Pub1ic or Random.

rssi
The signal strength in dBm of the received BLE frame.
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name

The name submitted by the BLE device. Only transmitted if the BLE scanner is activated in the BLE operational
settings.

advertisingData
The complete advertisement transmitted by the BLE device.
scanResponseData

The complete scan response transmitted by the BLE device. Only transmitted if the BLE scanner is activated
in the BLE operational settings.
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5 Configuring features with WEBconfig

The following section explains how devices are installed with WEBconfig and the various settings that WEBconfig has
to offer. These depend on the device, so not all of the listed options are available with every device.

5.1 Commissioning of a device via WEBconfig

WEBCconfig is reached via HTTP and HTTPS. If you use HTTP, the device automatically redirects you to an encrypted HTTPS
connection.

@ WEBconfig uses a self-signed SSL certificate, so this must be added as an exception in the browser for each
device.
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After invoking the WEBconfig interface of an unconfigured device, you can select whether the device should be managed
by the LANCOM Management Cloud or as a stand-alone device.

LANCOM Q

Systams

Welcome

Your new device needs to be configured before it can be used. For doing this, you have two options:

LANCOM Management Cloud Stand-alone

LANCOM Management Cloud

Configure and monitor the device with LANCOM Use WEBconfig on the device for configuration
Management Cloud. Employ our SD-WLAN and menitoring. When using WEBconfig, each
functionality for a simple rollout of multple device must be configured individually.

devices,

© 2018 - 2020 LANCOM Systems GmbH

Click the corresponding button here to decide whether the device should be managed by the LANCOM Management
Cloud or as a stand-alone device.
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5.1.1 Management by LANCOM Management Cloud

You either connect the device to the LANCOM Management Cloud by means of the serial number and PIN (zero touch),
or you use the corresponding input field to enter an activation code that you generated previously in your LANCOM
Management Cloud project:

LANCOM Management Cloud

Al

LANCOM Management Clowd

Please go to htps://cloud.lancom.de to add the
device to your project using the serial number
and PIN. The serial number is located on the
bottom side of the device. The PIN is printed on a

sheet which is enclosed with the original box:

LANCOM LW-500
[

RN O > |
Chced Pia: 113436

Alternatively, you can enter an activation code
that was generated in  your LANCOM

Management Cloud project:

Apply

After confirming the activation code and completing the pairing process, a success message will be displayed and you
will be redirected to the WEBconfig login page. The device can now be managed via the LMC.

5.1.2 Stand-alone management

Use the corresponding input fields to set a meaningful name for your device and set a password to be used by the user
“root”.
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@ The password set here is valid for the user “root”. This user is also used subsequently to login to WEBconfig.

Stand-alone

II o
_—
Please select a name for this device

New password for user root

| il

The password must contain

v 81to 128 characters
v Capital letters

v Small letters

v MNumbers

Repeat new password

Apply

Clicking on Apply will direct you to the login page. Use the username “root” and the previously defined password to
login to WEBconfig.

5.2 Login

Login by entering the user name “root” and the password you set earlier:

LW-500

Name

root l

Password

| =
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After logging in to WEBconfig you will be taken to the dashboard. Refer to section WEBconfig — Dashboard on page 69
for information on the dashboard.

5.3 WEBconfig — Dashboard

The dashboard provides an overview of the essential operating data for your device.

B O
Dashboard Dashboard
Neighborhood
Monitoring System ssiDs Wi-Fi
2 Wi-Fi configuration
System configuration Device LX-6400 ssip 2.4GHz 5GHz Authentication” 2.4GHz Channel6  802.01axtntg
Name Documentation # Documentation «  WPA(2}-PSK /‘ -
Logs
Location ’ < 2 O 2£|,
Comment 4 7_//
1P add 192.168.1.131/24, fe...
sedress g Clients  Channelload  Quality
Uptime 01:16:36
Firmware ve..
5GHz Channel64  802.11axtn#ac DFS Yes
CPU load

Clients Channel load Quality

[ ] L
=
Connected clients * c T =
Name ¥ =50) Signal strength IP address MAC address Standards Mode Throughput
No data
< © 2018 - 2020 LANCOM Systems GmbH

Below the dashboard are the areas Neighborhood and Monitoring.

5.3.1 Neighborhood

You reach the Neighborhood area by means of the Neighborhood item in the sidebar.

The Neighborhood view provides an overview of the WLAN environment, especially the WLAN access points and WLAN
routers that are locally active.
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Click the button Start scan to discover the WLAN environment. After the scan is completed (duration: approx. 10

seconds), the results are shown in various diagrams and tables:

Channel distribution 2.4 GHz

25—

20—

Number of 55105

I My LANCOM APs QOther APs

Neighborhood

55D

LANCOM-MGBILE

This AP

BSSID
00:0b:6b:ed:al:f7
00:0b:6b:ed:a1:00

Channel distribution 5 GHz

Number of 55/Ds

0-
26 40 44 48 52 58 60

I My LANCOM APs Other APs
Radio-Band Radia-Channel
5GHz 60
5GHz 140

104 108 112 116 132 138 140

This AP

C L v =

Signal-Level Noise-Level

-76 dBm -95 dBm
-71 dBm -85 dBm

The top two bar charts visualize the number of SSIDs detected by the device on the various 2.4-GHz and 5-GHz channels,
which can indicate the potential load on the channels. LANCOM access points detected by the scan and reachable on
the same LAN as the current device are highlighted as "My LANCOM APs". The WLAN channel that the current device

itself is working on is also indicated. The Neighborhood table also provides details about the SSIDs detected by the
scan, such as the name, the BSSID (MAC address), and the signal strength.

5.3.2 Monitoring

70

You reach the Monitoring area by means of the Monitoring item in the sidebar.

The Monitoring view is offers a graphical representation of the WLAN throughput, LAN throughput, number of WLAN
stations and channel load over time.
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(D The maximum amount of historical data available corresponds to the duration of the current WEBconfig session.

Wi-Fi throughput (total) Number of Wi-Fi clients
0 Mbps 0 dients

0.04 1
0.035
003
0.025
0.0z
0.015
0.01
0.008

0 - — - 0

12:00 12:05 12:10 12:15 12:00 12:05 12:10 12:15
W 2.4 GHz 5GHz W 2.4 GHz 5GHz
L]
LAN throughput (total) Channel load
0.04 Mbps 2%

0.08 100

0o7 50

80
0.08

70

0.05 h a0

0.04 50

0.03 4

\ \ :
0.02

'| [ 20

0.1 10 M A A SN A
0 0
12:00 12:05 12:10 1215 12:00 12:08 12:10 12:15
W LAN1 LANZ W 2.4 GHz 5GHz

5.4 Wi-Fi configuration

You reach this area by means of the Wi-Fi configuration item in the sidebar.

e Wi-Fi configuration

5.4.1 Concept

The Wi-Fi configuration is designed to assist the user with the most common settings and to eliminate the hassle of
configuring minor details. It remains possible to configure different scenarios.
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5.4.2 Operation

The available SSIDs are displayed in tabular form. Click on the Add new SSID button to configure a new SSID. A new
line is added. To configure an SSID with WPA2-PSK, all you have to do is fill out the fields Name, SSID and WPA2 key.

Metworks > SSiD > Encryption > Technology » ORcode »

Name SsID WPA2 Key

Documentation Documentation || sessssssssssssss o (&) 2.4GHz 5GHz

Depending on your needs, you can generate a secure WPA2 key automatically ( © ) and limit the frequency bands
available for selection. By default, the SSID is broadcast on 2.4 GHz and 5 GHz.

Then click on Save to accept your SSID. This will then be broadcast immediately by the device.

@ On the 5-GHz band, it may take up to a minute after the initial configuration to broadcast the SSID. This is due
to a requlatory requirement to monitor the band for primary users (“radar detection” for one minute, i.e. DFS).

@ Further individual configuration is possible by clicking on the respective heading.

Networks

Here you can set the parameters for each SSID as follows:

Networks

Network VLAN ID

Documentation
551D: Documentation 0

VLAN-ID

This VLAN ID is used to tag the data packets arriving from the WLAN and heading for the LAN. Similarly,
packets with this VLAN ID arriving from the LAN are directed to the WLAN and are de-tagged.

@ This operating mode corresponds to what is normally known as the “Access” tagging mode, since it
is assumed that wireless clients usually transmit data untagged. Tagging mode cannot be adjusted.

SSID
Here you can set the parameters for each SSID as follows:

SSID
Networks Allow traffic between clients Bandwidth limits per SSID Roaming IAPP-Passphrase Timeframes

IAPP-Passphrase
doc ’
SSID: doc only among own SSID 0 Wbps
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Allow traffic between clients

Depending on the application, it may be desirable—or even undesirable—for clients on a WLAN network to
communicate with other clients. Here you configure whether communication between the WLAN clients on
the WLAN network should be allowed.

Bandwidth limits per SSID

Here you set a WLAN bandwidth limit that applies to the entire WLAN network. All of the logged in clients
can only send and receive data with the transmission rate configured here. The value “0" means that no
limitation is active.

Roaming

Settings for switching a client from one access point to another access point that broadcasts the same SSID.

Standard

Enables key management according to the IEEE 802.11i standard without Fast Roaming and with keys based
on SHA-1. Depending on the configuration, the WLAN clients in this case must use opportunistic key caching,
PMK caching or pre-authentication.

Fast roaming

Enables fast roaming according to the IEEE 802.11r standard. See also Fast roaming on page 13.

@ Fast roaming is possible between devices based on LCOS and LCOS LX.

Standard+Fast-Roaming

A combination of standard behavior and Fast Roaming.

@ Although it is possible to make multiple selections, this is advisable only if you are sure that the clients
attempting to login to the access point are compatible. Unsuitable clients may refuse a connection if
an option other than Standard is enabled.

IAPP passphrase

This passphrase is used to implement encrypted opportunistic key caching. This is required to use Fast Roaming
over IAPP. Each interface must be assigned an individual IAPP passphrase in the WLAN connection settings.
This is used to encrypt the pairwise master keys (PMKSs). Access points that share a matching IAPP passphrase
(PMK-IAPP secret) are able to exchange PMKs between one another and ensure uninterrupted connections.
You should therefore ensure that this passphrase is identical on all of the access points that should operate
fast roaming.

Timeframe

Timeframes are used to switch individual SSIDs on and off according to a schedule. One profile may contain
several rows with different timeframes. Add the time frame here so that it is observed for this SSID.
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Edit Timeframes

Edit Timeframes x

Name Start Stop Weekdays
ALWAYS 00:00 23:59 Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, Holiday

NEVER 00:00 00:00 None

Close

Name

Enter the name of the time frame so that it can be referenced from the WLAN SSID. Several entries with the
same name result in a common profile. Predefined timeframes are ALWAYS and NEVER.

Home

The start time (time of day) can be specified in the format HH:MM (default: 00:00), from which the selected
profile becomes valid.

Stop

The stop time (time of day) can be specified in the format HH:MM (default: 00:00), from which the selected
profile ceases to be valid.

@ A stop time of HH:MM usually runs until HH:MM:00. The stop time 00:00 is an exception, since this
is interpreted as 23:59:59.

Weekdays

Here you select the weekday on which the timeframe is to be valid.

Possible values:

> Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, Sunday, Holiday

You can form a time schedule with the same name but with different times extending over several rows.

Encryption
Here you can set the parameters for each SSID as follows:
Encryption

Networks

WLAN-1
SSID: WLAN-1

Select authentication

Change the encryption and authentication method here. WPA2-PSK (WPA2 with pre-shared key or
WPA2-Personal) is preset by default. Optionally select No encryption or one of the following options:

> WPA3-PSK — WPA3 with pre-shared key or WPA3-Personal

> WPA(2+3)-PSK — WPA2 and/or WPA3 with pre-shared key
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> WPA2-801.1X— WPA2 with 802.1X or WPA2-Enterprise
> WPA3-801.1X— WPA3 with 802.1X or WPA3-Enterprise
> WPA(2+3)-801.1X— WPA2 and/or WPA3 with 802.1X

@ When using methods requiring a pre-shared key (PSK), you need to enter a WPA key. You can read
the key by clicking on the crossed-out eye symbol. Depending on your needs, you can automatically
generate a secure WPA key (@ ).

@ In the case of 802.1X you have to create a RADIUS profile. To do this, click on Edit RADIUS profile
and add a new line there.

Edit RADIUS profiles X

Name Port Secret Server-IP-Address Accounting-Port Accounting-IP-Address Backup profile MAC-Check

No Data

Close

Name

Choose a meaningful name for the RADIUS server profile here. This internal identifier is used to reference the
RADIUS server profile from other parts of the configuration.

Port
Select the port (UDP) used to contact the RADIUS server.

@ This is usually the port 1812 (RADIUS authentication).

Secret

Here you configure the secret used to encrypt the traffic between the device and the RADIUS server. This
secret must also be stored on the RADIUS server.

Server IP address
Here you configure the host name or IP address where the RADIUS server is to be reached.
Accounting port

Select the port (UDP) used to contact the RADIUS accounting server.

@ This is usually the port 1813 (RADIUS accounting).

Accounting IP address
Here you configure the host name or IP address where the RADIUS accounting server is to be reached.
Backup profile

Here you configure a backup profile, which will be used if the RADIUS server in the profile configured here
cannot be reached.
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MAC-Check

A user name can be authenticated with a MAC address instead of using the RADIUS server.

@ Please note that the RADIUS server generally has to be notified about the RADIUS client by means of
an entry in its configuration.

Store your changes by clicking on Save.

Encrypt management frames

By default, the management information transmitted on a WLAN for establishing and operating data
connections is unencrypted. Anybody within a WLAN cell can receive this information, even those who are
not associated with an access point. Although this does not entail any risk for encrypted data connections,
the injection of fake management information could severely disturb the communications within a WLAN cell.

The IEEE 802.11w standard encrypts this management information (protected management frames, PMF),

meaning that potential attackers can no longer interfere with the communications if they don't have the
corresponding key.

@ As of WPA3, management frames have to be encrypted, so the value there is ignored and is assumed
to be set as Mandatory. For WPA2, this is optional.

Technology

The Technology page offers the option to set fixed channels for the 2.4- and 5-GHz bands, to specify the available
channel width and to determine which radio mode is used. The default setting for all options is automatic selection.

@ The physical settings that can be configured here apply to the entire frequency band and are not SSID-specific.
Channel overview
Last scan: 1 Hour ago

2.4 GHz 5 GHz

207]

Number of 55I1Ds
Number of S5IDs

OauTo1 2 3 4 5 €8 7 &8 8 10 1 12 13 0 AUTO28 40 44 48 52 56 60 €4 100 104108 112 118 132136 140

Channel width Mode Channel width Mode

® Auto ® Auto @ Auo ® Auo
20 MHz 802.11axtntg 20 MHz 802.11ax+n+ac
40 MHz 202.11axtn*g+b 40 MHz 802.11n+ac
802.11ntg 80 MHz 802.11n+a
802.11b+g 160 MHz

The two bar charts visualize how many SSIDs the device detected on the various 2.4- and 5-GHz channels, which can
represent the potential load on the channels.
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@ The bar charts only contain information if a neighborhood scan has been performed under Neighborhood.

Client Management

The settings for band steering for Wi-Fi networks can be found here. Band Steering allows clients to be routed from the
overflowing 2.4 GHz frequency band to the 5 GHz frequency band, providing more bandwidth for each client and
improving the user experience. LCOS LX provides the ability to route clients to the optimal frequency band for them using
the 802.11v standard. Clients that do not support the 802.11v standard can also be routed to the 5 GHz band by delaying
sample responses or by selectively disconnecting from the WLAN. See also Band steering on page 12.

Client-Management

Band Steering
Active profile

Standard v

Active profile

Select the profile that defines the settings for the band steering module.

Standard

Steering is based on the medium load and the detected interference on the current channel and is preferably
done using 802.11v. If the client does not support 802.11v, steering is performed by means of a targeted
disassociation of the client. Steering is performed both before association and, if necessary, while the client
is already associated. This is the recommended profile.

Disabled
No steering is carried out at all. The client decides autonomously which frequency band to choose.
Legacy

Steering takes place before the client is associated by the targeted restraint of probe responses. The 5 GHz
band is always preferred regardless of the workload.

QR code

This page provides access to a QR code for any open or WPA2-PSK secured SSID. The QR code can be scanned by current
smartphones (an additional app may be required) and sets up the respective WLAN automatically on the smartphone.
This spares users the laborious entry of a wireless key.
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It is also possible to print out individual QR codes separately.

QR code

Documentation

SSID: Documentation

Export/Print

&= Print QR code

@ QR codes cannot be used for networks secured by 802.1X as they do not use a static WLAN key (PSK).

5.4.3 WLAN users

You reach this section in WEBconfig by means of the Wi-Fi user item in the sidebar.

=  WiFiuser

LEPS

When configured in LEPS, each user who should be able to authenticate client devices on the WLAN receives an individual
passphrase. LEPS profiles are used to avoid having to repeat all of the settings for every new user. You then create the
LEPS users with their individual passphrases and link them to one of the LEPS profiles created previously.

Alternatively, you can link the passphrase to a MAC address to set up a MAC address filter.
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Here you configure the Profiles and User for the LANCOM Enhanced Passphrase Security (LEPS). The switch Activate
LEPS enables the LEPS feature.

Name Profile WPA-Passphrase MACAddress VLAN

Profiles

Configure LEPS profiles here and link them to an SSID. You can then assign the LEPS profiles to the LEPS users.

Name
Enter a unique name for the LEPS profile here.
Network-Name

Here you select the SSID or, in the case of a WLC, the logical WLAN network for which the LEPS profile applies.
The only users who can authenticate at the SSID or, in the case of a WLC, at the logical WLAN network are
those who are connected to it via the LEPS profile.

Mac-List

Possible values:

Disabled

The MAC address plays no role during LEPS authentication. If any user-specific passphrase has been set, this
will be checked.

Whitelist

Only clients whose MAC address is known are admitted.
Blacklist

Only clients whose MAC address is not known are admitted.

VLAN
Here you specify which VLAN is assigned to a LEPS user or client who is connected to this profile.

Users

Create individual LEPS users here. Each LEPS user must be linked with a previously created profile and assigned an
individual WPA passphrase. Any client can then use this passphrase to authenticate at the SSID specified in the
corresponding profile. The passphrase identifies the user, who is assigned to the VLAN specified in this table. If no VLAN
is specified here, the user is assigned to the VLAN configured in the profile. Settings for the individual user thus take
priority over settings in the profile.
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Name
Enter a unique name for the LEPS user here.

Profile

Select the profile for which the LEPS user is valid. The only LEPS users who can authenticate at the SSID are
those who are connected to it via the LEPS profile.

WPA-Passphrase
Here you can specify the passphrase to be used by LEPS users to authenticate at the WLAN.

@ The passphrase can be a string of 8 to 64 characters. We recommend that the passphrases consist
of a random string at least 32 characters long.

MAC-Address

Optionally specify a MAC address for a MAC filter. The setting in the profile decides whether this entry is
ignored or whether the client devices listed in this table only are able to log on (whitelist). Using a blacklist,
the MAC filter works the other way round: the specified MAC addresses cannot log on.

Compared to simply assigning a passphrase to a user, managing a passphrase for each MAC address requires
a bit more work, but you have greater control over the devices in the network.

VLAN

Here you specify which VLAN is assigned to the LEPS user. If no VLAN is configured here, the VLAN configured
in the LEPS profile (if any) applies. If a VLAN is configured in both the LEPS profile and for the LEPS user, the
VLAN configured here takes priority.
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5.5 System configuration

This allows you to configure the basic parameters of your device, such as the device name or the IP settings for managing
the device.

LANCOM Q togour (1)

Systems

# Dashboard System configuration

Wi-Fi configuration

System configuration

Name: Documeniation #

Help

Device name
The device name is a helpful way for
identifying a device, especially when

LMC-Configuration >

Round-Trip Time: oms rmanaging mulitple devices of the
Management-Status: Not authenticated with LMC, no cloud management same type. If not specified explicitly,
this value will be auto-generated.
DHCP
This device requires additional TCP /
Configure the country > IP settings on the following pages. If
a DHCP server already exists in your
Current configuration: Europe network, you can operate the device

as a DHCP client or select the "Off"
mode. In ‘Client’ mode, all other TCP
1P sertings are made automatically

Adjust the security settings of this device > in your device. In the 'Off” mode,
further TCP / IP settings must be
made on the following pages.

NTP server
Select a time server that should be

Adjust the network settings of this device >

used for updating the device time.

1Pv4 mode: DHCP
IPv4 address: 192.168.1.131/24
IPv4 gateway: 192.168.1.1
IPv6 mode: Link-Local
IPvE address: feg0::2a0:57fffedc:45b3/64
1PV gateway:
802.1X-Supplicant Mo
< © 2018 - 2020 LANCOM Systems GmbH

You can edit individual fields such as the system name by clicking on the check mark next to it. An edit mask for the
various sections opens after clicking on the headline.

5.5.1 Name

Configure the device name here.

System configuration

Name: Documentation #
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5.5.2 LMC configuration
Use the LANCOM Management Cloud to pair your device subsequently.

LANCOM Management Cloud Pairing X
An activation code is needed to integrate one or several of your LANCOM devices securely
into the cloud while simultaneously linking them to a particular project or organization.

Direct control access to your LANCOM devices is needed.

Activation Code:

Public Cloud (Default)
Private Cloud
LMC-Domain

cloud.lancom.de

@ Use current device configuration
Cancel Confirm

Activation code
Enter the activation code that you generated in your LANCOM Management Cloud project earlier.
Public Cloud
This option specifies the LMC domain of the Public Cloud from LANCOM.
Private Cloud
With this option you can specify the LMC domain of your private instance of the LANCOM Management Cloud.
LMC domain

Shows either the LMC domain of the Public Cloud or you enter the LMC domain of your private instance of
the LANCOM Management Cloud.

Use current device configuration
Applies the settings already configured in the device.
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5.5.3 WLAN management

Specify here whether your device is managed by a WLAN controller.

WLC configuration X

Operation
This configures whether an access point actively searches for a WLC and can be managed by one.

@ This option should be deactivated for operation in stand-alone mode.

5.5.4 Location based services

LANCOM access points are able to function as LBS clients with an LBS server. In this case, they report any connected
clients to the LBS server, which can then offer location-based services to those clients. As of LCOS LX 5.30, an HTTP
interface is supported. This must be configured via LANconfig, see Location-based services (LBS) on page 61.

Location Based Services X

m
N
4
]}
T

Lance

Operation
By turning on the BLE radio here, data about the BLE environment is collected continuously.
BLE Scan Type

Choose between a passive and an active scan. The BLE name and a scan response can only be detected in
the active scan. Note that BLE clients answering scan requests can increase power consumption.
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CA certificate
If you have uploaded a certificate for the HTTPS protocol to the device, it will be displayed here.

CA-certificate-upload
If you use HTTPS, a CA certificate for server verification must also be uploaded to the device. You can do this

here by selecting the certificate file and then uploading it.

HTTP-Server
Under HTTP-Server you configure the HTTP endpoints for the LBS data.

Location Based Services: HTTP-Server

URL Secret

Showing 0 of 0 records

URL
Configure the URL of the HTTP endpoint here.

@ HTTP and HTTPS are supported. If you use HTTPS, a CA certificate for server verification must also be
uploaded to the device. This can be done using WEBconfig. See Location based services on page 83.

Secret
The secret (key) is transmitted from the access point to the end point in the JSON messages and can additionally

be used for message authentication.

Data-Sources
Here you configure the types of LBS data that should be sent. Only BLE is currently available.

BLE-Measurements-Fields
Here you configure which measurement fields or data from the access point should be included in the messages

to the HTTP endpoint. In order to minimize the data volume, we recommend that you limit this to essential

data only.

Buffering Timeout
After the configured time (in seconds) is reached, all BLE messages buffered up to that point are sent to the

server.

Buffer Size
After the configured data quantity (in bytes) is reached, all BLE messages buffered up to that point are sent

to the server.
@ With the value for Buffering Timeout and Buffer Size both set to 0, the messages are sent to the

server as soon as possible.
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5.5.5 Wireless ePaper

LANCOM Wireless ePaper Displays provide a variety of options for displaying information. You can automatically and
remotely update the calendar schedule for your conference rooms, you can create dynamic notices and direction signs,
or you can control the price labels of goods on your shelves from a central location in real time. The wide range of
different settings allows you to set up your very own customized use case.

The settings for operating Wireless ePaper Displays are to be found in LANconfig under Tools > Options > Wireless
ePaper. Under IP/hostname you enter the IP address and the port of the Wireless ePaper Server. The recommended port
number is 8001.

You invoke the Wireless ePaper management in LANconfig under Tools > Start Wireless ePaper management.

Wireless ePaper X
Operarting

No v
Protoco
Channe

Channel 0 (2404 MHz) v
Server Port
Server Authentication

No v
Server Hostname Ve tion

No v
CA-certificate

ertificate unvailable
Operation

Use this to activate the Wireless ePaper feature in the access point.

@ The server must be configured for the connection type ThinAP2.0/TCP. Please refer to the LANCOM
Support Knowledge Base for further information. Use the same method to set the following two
configuration options to enable communication between the server and LCOS LX access points:

accessPointUseThinMode?value=true
accessPointThinUseOutboundMode?value=true

This can be done, for example, with “curl” as follows:

curl -X PUT http://localhost:8001/service/configuration/accessPointUseThinMode?value=true
curl -X PUT http://localhost:8001/service/configuration/accessPointThinUseOutboundMode?value=true
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@ The legacy connection mode via UDP is not supported by LCOS LX.

Protocol
The protocol used to communicate with the server.
Channel

Configure the radio channel to be used for controlling the Wireless ePaper Displays.

@ Depending on the radio channel used, connecting the server to a Display can take up to 30 minutes
(channels 3, 5, 8,9, 10) or up to 120 minutes (channels 0, 1, 2, 4, 6, 7). If possible, you should prefer
the channels 3, 5, 8, 9 and 10, as Wireless ePaper Displays scan them more frequently and they do
not interfere with the popular Wi-Fi channels 1, 6, and 11.

Output Power
[mw]

- Frequency
——— Wireless ePaper Channels Recommended Channels [MHz]
—— WLAN Channels ——— Altenate Channels

@ Do not select the same channel for two access points that are in the same area. This causes interference
and prevents Displays from joining the network. It is possible to set the same channel on two access
points if you are sure that each display is only within range of one of these access points.

Server address

Here you configure the IP address of the Wireless ePaper Server that the access point should contact.
Server port

The TCP destination port to be used for communication with the server.

Server Authentication
Optionally, the access point can check the server certificate of the Wireless ePaper Server when it connects
to it. If this option is enabled, a corresponding CA certificate (or certificate chain) in PEM format must also
be loaded onto the access point via WEBconfig.
Server Hostname Verification
In connection with the Server Authentication option, this setting decides whether the “Common Name”
specified in the certificate is checked for a match with the host name of the addressed Wireless ePaper Server.
CA certificate
If you have uploaded a certificate to the device for server authentication, it will be displayed here.

CA-certificate-upload

If you use server authentication, a CA certificate for server verification must also be uploaded to the device.
You can do this here by selecting the certificate file and then uploading it.
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5.5.6 Country settings

Here you configure the country where the device is operated. Depending on this, the appropriate regulatory restrictions
are set automatically.

Country settings X
The country is used to determine the correct parameters for Wi-Fi networks.

Please select the country according to the location of the device:

Europe v

Cancel

5.5.7 Security settings

Here you can change the password for the current user (usually “root”).

Security settings

Password

Change the password of the currently logged in user.

Current password

L

New password for user root
©
The password must contain
v 810 128 characters
v Capital letters

v Small letters
v MNumbers

Repeat new password

L

Cancel Confirm
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5.5.8 Network settings

Here you have the option to change network settings of your device, such as its IP address.

Network settings X
IPv4 settings

@ Dynamic Static
Current configuration

IPv4 address: 192.168.1.131/24
IPv4 gateway: 192.168.1.1

IPv6 settings

Router Advertisement Dynamic @ Static
IPv6 address:
/64

P P
IPv gateway:

IPvE primary DN5:

Cancel

IPv4 settings
Dynamic

Uses DHCPv4 to configure the IPv4 parameters. This is the default value.
Static

Uses the IP parameters that you can configure in the fields IPv4 address, IPv4 gateway, IPv4 primary
DNS and IPv4 secondary DNS.

@ Note that the IPv4 address must be specified in CIDR notation (for example, 192.168.1.1/24).

IPv6 settings
Router Advertisement

Uses router advertisements/SLAAC to configure the IPv6 parameters. If the received router advertisement
contains the M (managed) flag, further parameters are obtained via DHCPv6.

Dynamic

Uses DHCPv6 to configure the IPv6 parameters.
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Static

Uses the IP parameters that you can configure in the fields IPv6 address, IPv6 gateway, IPv6 primary
DNS and IPv6 secondary DNS. This is the default value.

802.1X supplicant

These are the settings for the 802.1X supplicant functionality, which authenticates the device towards the LAN at a
switch infrastructure secured by 802.1X.

User name

The user name to use to authenticate at the 802.1X infrastructure.
Password

The password to use to authenticate at the 802.1X infrastructure.
Method

The EAP method used to authenticate at the 802.1X infrastructure.

5.5.9 Time zone settings

Time zone settings X

Time zone
uUTC v
Enable NTP
NTP server

time.google.com v

Cancel

Time zone
Select a time zone. The default value is “UTC".
Enable NTP

Here you select whether the time should be obtained from a time server by means of the network time protocol
(NTP).

NTP server

From this list you select a time server from which the time is to be obtained via NTP.
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5.5.10 Automatic firmware update

Firmware Update X

Update Mode
Check & update

Check Interval
daily

Version Paolicy

latest version

Start of the check time window End of the check time window:

0 = o' clock 4] = o' clock
Start of the update time window End of the update time window

2 : o' clock 4 : o' clock
Base-URL:

https:/fupdate.lancom-systems.de A

Cance

Update mode

Set the operating mode here. The following modes are supported:
Check & update

> The Auto Updater reqularly checks the update server for new updates.

> The update server uses the update policy to find the most suitable update, it sets the time to download
and install the update within a time frame configured by the user, and it sends the update to the Auto
Updater.

> The firmware is installed in test mode. After installation, the Auto Updater performs a connection check.
Here, the device checks whether a connection can be established to the update server to ensure that
Internet access is still available. These attempts continue for several minutes to allow for VDSL
synchronization or WWAN connection setup. If the update server is contacted successfully, the test mode
terminates and the firmware goes into regular operation. If the update server cannot be contacted, then

Internet access is assumed to be impossible and the second (i.e. the previously active) firmware will be
started again.

Check
> The Auto Updater reqularly checks the update server for new updates.

> The availability of a new update is signaled to the user in the LCOS LX menu tree and via syslog.
> Users can manually use the Auto Updater to initiate the latest available update.

@ A manual update is started with the following entry on the command line:
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do /setup/Automatic-Firmware-Update/Update-Firmware-Now

Manual

> The Auto Updater only checks for new updates when prompted by the user.
> Users can manually use the Auto Updater to initiate the latest available update.

@ A manual update is started with the following entry on the command line:

do /setup/Automatic-Firmware-Update/Update-Firmware-Now

Check interval
This decides whether checks for an available update are performed daily or weekly.

Update policy

Latest version

Always the newest version, irrespective of the release version. Example: 4.00 Rel is installed; an update to
4.00 RU1 is performed, but also to 5.00 Rel. Updates always go to the latest version, but not back to a previous
release.

Current version

The latest RU/SU/PR within a release. Example: 4.00 Rel is installed; an update to 4.00 RU1 is performed, but
not to 5.00 Rel.

Security patches only

The latest SU within a release. Example: 4.00 Rel is installed; an update to 4.00 SU1 is performed, but not to
4.00 RU2.

Latest version w/o REL

The newest RU/SU/PR, irrespective of the release version. Updates are only performed if a RU is available.
Example: Any version of 4.00 is installed; an update to 5.00 RU1 is performed, but not to 5.00 REL.

Check time window

Set the time frame for checking and downloading new updates here. The daily start and end time for this
time frame can be set to the hour. The default value for both of these is 0, so checks for updates and downloads
can be started at any time of day. The Auto Updater schedules a random time for update checks and downloads
within the configured time frame.

Update time window

Set the time frame for update installations here. The daily start and end time for this time frame can be set
to the hour. The default setting specifies a time frame between 2:00 AM and 4:00 AM. If an update is found,
it will be installed during this time and the device will be restarted to activate the update. The Auto Updater
schedules a random time for the installation within the configured time frame.

Base URL
Specifies the URL of the server that provides the latest firmware versions.
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5.5.11 SNMP

SNMP X

Operating:

Yes v
Port:

161
Administrators have SNMPv3 access according to their device access rights:

No v

Cancel

Operation

Activate SNMP.
Port

If necessary, adjust the port used for SNMP. Default: 161
Administrators have SNMPv3 access according to their access rights

Enable this option if registered administrators, including the root user, should also have access via SNMPv3.
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6 Diagnosis

6.1 Trace output

Trace output can be used to check the internal processes in the device during or after configuration. Experienced users
can read this output and discover any errors in connection establishment. One particular advantage is: The error may
be located in the configuration of your own device or in the peer device.

@ Trace output has a slight time delay from the actual event, but the order of events is always recorded correctly.
This generally does not influence the interpretation of the display, but this should be considered when making
precise analyses.

6.1.1 Trace — an overview
Trace output is started in a CLI session. Set up an SSH session to the device. Call the trace with the following syntax:

> trace [--log] [+|-|#|?] <Parameter>

The command trace, the key and the parameters are each separated by a space. The keys control the trace while the
parameter determines the actual output.

Table 2: Overview of keys

Key Meaning

--log Output of “historical” Information from the log
? displays help

+ switches trace output on

- switches trace output off

# Toggles “"between the different trace outputs

no key displays the current status of trace

Table 3: Overview of parameters

Parameter Meaning --log

WLAN WLAN-related outputs, such as client log ins and log offs, key negotiation, ... Yes

If the trace is not enabled, the log file will contain only a small amount
of information and the “historical” output will not be particularly

informative.
IAPP Output on IAPP (inter access point protocol) Yes
Kernel Output on the basic system and kernel. Yes
SSH Output on the SSH service. Yes
* Wildcard, which stands for all services. Depends on the service
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6.1.2 Trace — operation
The following examples illustrate the functions of trace:

> Start one or more traces:

trace + ssh kernel

> Stop traces:

trace - ssh kernel

> Stop all traces:

Crezee = &

un

> Toggle between ““switching the traces on and off:

trace # ssh kernel

> Output “historical” information, if supported and available in the log:

trace --log + kernel

6.2 Logs in WEBconfig

You reach the “Logs” area by means of the Diagnosis > Logs item in the sidebar.

IIE%IIII!H%%IIIIIIIIIIIIIIII

This area outputs the device SYSLOG.

Logs

Ie

Automatically refresh view every | 10 seconds G Refresh now

Time Level Message

2019-04-24 16:10:44 warning [700399.503763] dfs_confirm_radar: Rejecting Radar since Fractional PRI detected: searchpri=490, threshold=6, fractional PRI=24!
2019-04-24 16:05:17 warning [700072.074115] [wifi1] FWLOG: [35570808] WAL_DBGID_SECURITY_ALLOW_DATA ( 0x4410b0 )

2019-04-24 16:03:17 warning [700072.074101] [wifi1] FWLOG: [35570809] WAL_DBGID_SECURITY_ENCR EN ()

2019-04-24 16:05:17 warning [700072.074038] [wifi1] FWLOG: [35570809] WAL_DBGID_SECURITY_UCAST_KEY_SET ( 0x5643, 0xD )

2019-04-24 16:05:17 notice  hostapd: WLAN-2-01: AP-STA-DISCONNECTED c4:61:8b:72:56:43

6.3 Packet capturing in WEBconfig

This item allows you to capture Wireshark-compatible packets.
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You reach this section from the sidebar under Diagnosis > Packet capturing.

= Packet capturing

Create capture

Interface-Selection

select ...

Packet-Limit

Create capture Create and start capture

In the section “Created captures” you can specify the interface where packets are to be captured and whether the capture
size should be limited by the number of captured packets.

The interfaces available for selection include all Ethernet interfaces as well as active WLAN SSIDs (separated according
to frequency band).

Click on Create capture and a capture job is created with the chosen settings, but it is not yet started. The capture can
then be started at any time from the “Created captures” list. Click on Create and start capture to create a capture job
with the chosen settings and start it inmediately.

Using the “Created captures” list you can start, stop and download captures as a .pcap file.

Created captures

04.12.2020 13:24:19 ETH1 Complete 04.12.2020 13:24:19 2808

©

Capture data is streamed directly from the access point or WEBconfig into the browser's cache. Please note that
a capture job that has been started is aborted when you close WEBconfig.

©

Different capture jobs can be started in parallel.
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